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External video links 

 

We advise you to watch the start-up videos (external link):  

https://mastroapp.com/en/videos/getting-started 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Go to:  Main menu 

https://mastroapp.com/en/videos/getting-started
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Overview 
 

 

 

 

 

 

 

 

 

  

 
 

 

 

 

 
 

 

 

 

 

 

 

 

Go to:  Main menu 

Command buttons to open 

and calculate a chart in the 

Middle wheel with the 

Transits, Secondary 

Progressions, Solar Arc 

Directions, Tertiary 

Progressions, Profections, 

Symbolic Directions or 

Synastry method. 

. 

Command buttons to open 

and calculate a chart in the 

Outer wheel with the method 

Transits, Secondary 

Progressions, Solar Arc 

Directions, Tertiary 

Progressions or Profections. 

 

Command buttons for Show 

All Aspects, Print, Scan 

Aspects, Show Graphs and 

adjust the angle and 

direction of a desired aspect 

using the drag of a planet on 

a point. 

 

Toolbars for quick access to 

the curves, or to temporarily 

adjust the orbs (% zoom) and 

display all aspects for the 

inner wheel, the middle 

wheel or between the two 

wheels. These bars are 

displayed according to your 

choices in the Tools menu, 

under the Toolbars item. 

 

 

• Primary 

Direction 

• Solar Return 

 

See next page: The 

panels on the left of the 

screen. 

Data panels on the 

different wheels. They are 

present or not depending 

on the choices made in 

the General tab in the 

Preferences. 

Inner 

wheel 

Middle 

wheel 

Outer 

wheel 

If you right click the mouse on the 

surface around the chart, you get the 

Contextual menu which presents the 

main functions of Mastro. 

 

Choice of language 
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The panels on the left of the screen  
 

  
 

 

 

 

 

Go to:  Main menu 

Inner panel - Controls (buttons) for the inner wheel: 

• New Chart  

• Open a chart 

• Change location 

• Use orbs 

• Hide (positions) 

• Harm. (harmonic) 

The last chart observed in the inner wheel will be loaded again the next time 

Mastro is started. The drop-down menu on the left side of the panel (in the 

example: Adele) keeps the charts opened during the session. So, you can go back 

to the previous chart. 

 
The Middle and Outside panels contain the same basic controls as the Inner 

panel. To get a transit or secondary progression in the Middle wheel, use the T 

or PS (Middle section) command buttons on the Mastro menu bar (Same for 

the other methods). 

 

• The Houses and Zodiac Panel offers controls for choosing houses, choosing 

the zodiac, geocentric or heliocentric view and other display settings. 

 

• The Date and Time Navigator panel offers a key-pressed calendar for 

moving through time. Mastro is dynamic, it will recalculate the transit or 

progress at each change. Ctrl + N (N for Now) calculates the positions for 

the active chart at the current date. A few buttons on the right side of the 

panel allow you to set a date for a possible recall during the session. 

 

• The Astro Event panel offers search functions.  

 

• The Midpoints panel dynamically displays the midpoints under the mouse 

cursor or the midpoints in transit on a planet of the inner (natal) wheel. 

The midpoints in transit on a natal point are revealed by pressing Ctrl + 

left mouse click on a natal planet. 

 

• The Periods and Planetary Forces panel for the inner wheel offers the 

following calculations: Ashtakavarga, Dasha. Firdar. 

 

• The Dynamic Aspectarium panel displays the aspects in a classic grid or as 

an ordered list. Clicking on an element (aspect) highlights the aspect in the 

Aspectarium and draws the aspect on the chart. If the Interpretation 

panel is open, the two paragraphs of keywords associated with the two 

planets and the aspect concerned will be displayed. If you click again on 

an aspect already selected, then its highlighting will disappear and its plot 

on the chart and its keywords will be erased. 

 

• The Interpretation, Analysis and Synthesis panel offers the keywords for 

the planets (and their aspects) under cursor. 
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Tabs:   

• Commands  

• Charts list 

• Moon phases  

• Other Data 

 

A right mouse click on a panel header offers the 
option to close all panels. 
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Delete all 

interpretations 

 

? 

1 level 

quick 

analysis 

2 level 

analysis 

AI (GPT) 

Options for 

interprétation 

and analysis 

Show all 

aspects 
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How to create a new chart 
 

There are 3 ways to call up the data entry window: by clicking on the New Chart button (white page) in the Interior 

panel, through the Contextual menu or through the Files menu. 

 

1) In the Interior panel: click on the New Chart button.   

  

 
2) From the Contextual menu: Select, New (Inner Chart)  

 

  
 

3) Through the menu Files: 

  

 

Go to:  Main menu 

Click the arrow to expand or 

collapse this panel. 
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The New Chart windows. 
 

  

Your data will be stored in one of the databases you can select before clicking Ok. Here the selected database is Clients 

database. Note that the default database is User Database. 

The fields with the yellow highlighted frames are mandatory.  The city name (Place) is required if you want to search for 

a city in the city database, but the presence of this name in the Place field is not mandatory. Even after selecting a city, 

you can change the latitude, longitude, and time difference with GMT. Longitudes west of Greenwich are negative and 

those easts are positive. 

After entering your data, press OK to save and close the window.  

 

 

 

 

 

 

 

 

 

Go to:  Main menu, Overview. 

Alternative method - There is an alternative method for creating a chart from the data in the inner wheel. For example, suppose 

there is only the inner wheel active, and you press Ctrl + N to get the current planetary positions (mundane) chart for your location. 

You can change the date and time by clicking on the Date and Time in the center. You can click the Change Location command and 

change the latitude and longitude. Finally, right-click in an empty space and click Save Inner Chart As... on the Contextual menu. The 

Name of the Chart window will allow you to choose the database and name you want to give this chart. 
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The New Chart or Open Chart window - Detailed description 
 

 

The data entry window is shown here in "Edit" mode, i.e., the Open Chart command has been selected and the Modify 

button has been clicked. When you click on the Modify button, the section on the right becomes editable. If we click on 

another name in the list on the left, then the section on the right becomes read-only and we will have to click on the 

Modify button again if we want to make the section on the right editable.  

Here is an overview of the commands on this screen, the mandatory fields are circled in yellow on the screen and 

underlined below:  

The database control allows you to select one of the following databases: User database, Public database, Tutorial 

database, Clients database. The Public database is reserved by Mastro Software where we can add, modify, or remove 

data during subsequent updates.  

Name: Our convention for public database is to put the last name followed by a comma and the first name. You are free 

to put what you want and free of the format. 

Contact: Open the contact window to enter other information: phone number, email address, etc. 

Type: Natal or Mundane. 

Date: Year, month, and day of birth. 

Date format 
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Calendar:  Useful for selecting a date with the mouse. 

Accuracy: Grading according to "Rodden". In the public data, we mainly use data of type AA, A, or B. 

Time: You can click on the hour, minutes, or seconds inside the control to change them. You can use the up and down 

arrows on your keyboard, or you can click the arrow on the screen. 

Midnight: Quick command to set the time at midnight. 

Noon: Quick order to set the time at noon. 

Now: Quick command to set the time to now. 

Local Time: Indicates that the time is local time, at the coordinates defined below. 

Universal time: Indicates that the time is universal time (at Greenwich), at the coordinates defined below. The time 

difference with GMT is automatically adjusted to 0 in this case. 

Place: City name or, city name and region or country.  The Use Default Place button below automatically fills in the Place, 

Lat., Long. and Time difference with GMT fields. 

Search city:           This command will search for the city in our city database and if Mastro finds more than one city, you 

will be presented with a city selection window. When a city is selected, the fields Lat., Long. and Time difference with 

GMT are filled in automatically. 

Lat.: Latitude. You can change the input format by checking or unchecking the box Lat./Long. in deg. Decimal. You can 

enter a value here after other operations and this will be the value that prevails. 

Long: The longitude. You can change the input format by checking or unchecking the box Lat./Long. in deg. Decimal. 

You can enter a value here after other operations and this will be the value that prevails. 

Lat./Long. in deg. decimal: Check or uncheck this box to change the input format for latitude and longitude. 

Time difference with GMT: A negative value represents the time difference with Greenwich for a West longitude. A 

positive value represents the time difference with Greenwich for an East longitude.  

Use Default Place: Command that automatically fills in the fields Place, Lat., Long. and Time difference with GMT with 

the data defined in the Preferences (Tools menu) in the General tab. 

Add to my list of places: This command saves the data entered in the fields Place, Lat., Long. and Time difference with 

GMT. (See below for what My list of places is.) 

Modify my list of places: Allows you to edit My list of places. (See below for what My list of places is.) 

My list of places: This is a user-managed database of cities that allows you to fill in the Place, Lat., Long. and Time 

difference with GMT fields from a list of places registered by the user. This list is constructed from the entries made in 

the Place, Lat. and Long. fields and the Time Difference with GMT field followed by the Add to my list of places 

command. This requires that we first locate an existing city (by clicking Search city) for which we have a key that allows 

us to associate the time change history of the existing city with the city we want to add. The city initially chosen gives us 

the key (not visible on the screen). Then we can modify the name of the place and all the coordinates before clicking 

Add to my list of places. This procedure is intended to ensure that Mastro's automatic time changes work when we are 

walking through time. The commands Add to my list of places and Modify my list of places are also present in the 

inner, middle, and outer panels when clicking on the Change Location button. The data added to My list of places is 

available in the list of cities when you click on Search city. 

The STD, DST, WAR, and Double radio buttons only display the time status and do not affect the value of Time 

Difference with GMT. 

LMT: Abbreviation for Local Mean Time, which converts longitude into time difference with the Greenwich meridian. 
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LAT:  Local Apparent Time. By clicking this control, Mastro converts the time value (in true time, also called local 

apparent time) with the equation of time to arrive at an LMT time usable for the calculation of angular and planetary 

positions.  

Link: Field available for public data to establish the source of the data. 
 
Time change, Time zone map, Latitudes and Longitudes are useful links (external link subject to change)  
 
Modify: This command is available under Open Chart and allows you to edit the values of the fields in the right section of 
the Open Chart window, for the name selected (one clicks only) in the list of Charts. 
 
Duplicate: This command is available under the Open Chart window and allows you to make a copy of the data of a 
selected chart by first clicking (one click) on the name in the list of charts and then on the Duplicate button. 
 
Delete: This command is available under Open Chart and allows to clear the data for the selected name (one click) in the 
list of charts. 
 
Sauvegarder : Sauvegarde les valeurs entrées ou modifiées dans la section droite de la fenêtre, sans quitter la fenêtre 
Ouvrir une carte. Le fait de demeurer dans la fenêtre permet, par exemple, de cliquer un autre nom dans la liste et de 
faire d’autres changements. 
 
Save: Saves values entered or changed in the right-hand section of the window, without leaving the Open Chart window. 
Remaining in the window allows you, for example, to click another name in the list and make other changes. 
 
Ok: Saves the new data or changes when editing and closes the New Chart or Open Chart window. 
 
Cancel: closes the window and abandons all changes 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Go to:  Main menu, Overview. 
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How to open an existing chart 
 

There are 3 ways to open a previously saved chart: By clicking on the Open Chart (Folder) button in the Interior 

panel, through the Contextual menu or through the Files menu. 

 

1. In the Interior panel: click on the Open chart button.   

  

2. From the Contextual menu: Select, Open (Inner Chart).  

   

  

3. Through the menu Files :  

     

Go to:  Main menu, Overview 
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The Open Chart windows. 
 

 

 

 

 

 

 

 

 

 

 

 

 

Go to:  Main menu, Overview  

Select the chart to be consulted in the list: double click on the item or 

select it with a click then click on the Ok button. 

 

Select the database where the desired natal chart is located. Normally and by default the User database is selected. In this 

example, the Clients database has been selected. You can also select Public database or Tutorial database. 
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How to modify an existing chart 
 

1. Open the chart to be modified by using the File menu or the Contextual menu or, as here, by clicking the Open 

Chart command (yellow folder) in the Inner panel: 

 

2. Click once on the name for which you want to modify the data. Then click on the Modify button. 

  

 

3. The fields to the right of the list will become editable. Make your changes and then press Ok to keep the 

changes and close the window. 

 

 

 

Go to:  Main menu, Overview  
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How to display transits (TR) 
 

To see the transits in the middle wheel, click T on the menu bar. By default, the transits of the present time will be 

displayed in the middle wheel. They will be displayed for the location defined in the Preferences (Tools menu, General 

tab). 

 

If you want the transits for a different location than the one defined in the Preferences, you must click on the Change 

location button for the active wheel. 

  

From this moment on, you can navigate in time... 

• with the keys on the keyboard (arrows): ￩￪￬￫ 

• by clicking on a date in the calendar (under Date and Time Navigator in the left panels)  

• or by clicking on the date in the center of the inner wheel.  

• The hours, minutes and seconds are adjustable by clicking on the hour in the center.  The hours, minutes and 

seconds can also be changed with the H, M and S keys. 

See Keyboard Shortcuts in the Help menu. The Ctrl key is usually used in combination with the keyboard keys to move 

backward in time for hours, minutes and seconds, but with the arrows they change the unit of time (e.g., days vs. 

weeks, vs. months). 

To better understand the movement of the arrows on the keyboard, you can open the Date and Time Navigator panel 

and observe the changes in the calendar depending on the keys used. 

 

The converse transits. 
 

Converse transits are activated under the window Change date: 

       

 

 

 

 

 

 

  

Click on the converse date to calculate and 

display the transit at that date. (Toggle between 

start date and conversion date) 
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Go to :  Main menu, Overview, Navigation in Time, Display Option for Date and Time,  Transits - configurations 

How to display the secondary progressions (PS) 
 

To see the secondary progressions, in the middle wheel, click PS on the menu bar (Middle section). The secondary 

progressions will be displayed for the current moment if the middle wheel is closed. If there was already a transit chart, 

directions chart or otherwise, in the middle wheel, the time set for that chart will be retained. By default, secondary 

progressions are calculated for the birthplace. (Can be changed in the Preferences). 

 

Just like the transits, the date and time are modified ... 

• with the calendar in the Date and Time Navigator panel. 

• by clicking on the date in the center. 

• with the arrows and the H, M, S keys. 
 

 

Converse secondary progressions 
 

The converse secondary progressions are activated under the Secondary Progressions - Configurations window, by 

right-clicking on the PS button (main menu bar) or through the Preferences on the Calculations tab. 

 

You can see the progress date in the Change date window: 

 

Go to :  Main menu, Overview, Navigation in time,  Secondary progressions - configurations 

  



19 
 

Mastro - User guide - v.7.7 (May 2025) 

How to display the solar arc directions (DA) 
 

To see the solar arc directions, in the middle wheel, click DA on the menu bar (Middle section). The solar arc directions 

will be displayed for the current moment if the middle wheel is closed. If there was already a chart of transits, 

progressions or other, in the middle wheel, the time set for that chart would be retained. By default, the solar arc 

directions are calculated for the birthplace. (Can be changed in the Preferences). 

 

Like transits and progressions, the date and time are changed.... 

• with the calendar in the Date and Time Navigator panel. 

• by clicking on the date in the center. 

• with the arrows and the H, M, S keys. 

 

 

Converse Solar arc directions 
 

The converse solar arc directions are activated under the Solar Arc Directions - Configurations window, by right clicking 

on the DA button (main menu bar) or through the Preferences in the Calculations tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Go to :  Main menu, Overview, Navigation in time,  Solar Arc Directions - Configurations 
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How to display the tertiary progressions (PT) 

 

To see the tertiary progressions, in the middle wheel, click PT on the menu bar (Middle section). The tertiary 

progressions will be displayed for the current moment if the middle wheel is closed. If there was already a transit chart, 

directions or otherwise, in the middle wheel, the time set for that chart will be retained. By default, tertiary 

progressions are calculated for the birthplace. (Can be changed in the Preferences). 

 

Like transits and secondary progressions, the date and time are changed.... 

• with the calendar in the Date and Time Navigator panel. 

• by clicking on the date in the center. 

• with the arrows and the H, M, S keys. 

 
 

Mastro offers two types of tertiary progressions. To adjust the type, right-click on the PT button (main menu bar) to call 

up the Tertiary Progressions - Configuration window or click the Tertiary Progressions button in the Preferences on the 

Calculations tab. 

 
We offer 3 ways of calculating angles in Tertiary Progression, depending on the progression step per day:: 

• Naibod 

• Solar Arc (average annual movement) 

• 361° 

 

Go to :  Main menu, Overview, Navigation in time, Tertiary Progressions - Configuration   
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How to display the profections (PF) 

 

Profections are like solar arc directions and symbolic directions in that they maintain the symmetry of natal positions. 

The natal sky is advanced 30 degrees per year. The annual profections are the planetary positions calculated for the 

time of the solar return. To get the annual profections, you must therefore calculate the solar return first.  Otherwise, 

Mastro advances the planetary positions up to 30 degrees per year. This movement is spread out over a year, as far as 

you advance in the year. 

To view the profections, in the middle wheel, click PF on the menu bar (Middle section). The profections will be 

displayed for the present time if the middle wheel is closed. If there was already a chart of transits, directions or other, 

in the middle wheel, the time set for that chart will be retained. By default, the profections are calculated for the 

current location (which can be modified in the Preferences). 

 

Like transits, the date and time are changed.... 

• with the calendar in the Date and Time Navigator panel. 

• by clicking on the date in the center. 

• with the arrows and the H, M, S keys. 
 

There is no converse movement for profections and no configuration. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Go to:  Main menu, Overview  
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How to display the symbolic directions (SD) 
 

The symbolic directions are like solar arc directions, they keep the symmetry of the natal positions, but move forward 

one fixed degree at the time of the solar revolution. Otherwise, the planets remain fixed for the following year. 

To see the symbolic directions, in the middle wheel, click DS on the menu bar (Middle section). The symbolic directions 

will be displayed for the present time if the middle wheel is closed. If there was already a chart of transits, progressions, 

or whatever, in the middle wheel, the time set for that chart will be retained. By default, symbolic directions are 

calculated for the birthplace. (can be changed in the Preferences). 

 

You can configure the annual step size by calling up the symbolic directions configuration window (right mouse click on 

the button). Three options are available: 1° per year, 0° 59' 8.33 (Naibod's value) per year, 1.168° (the golden number) 

per year or the value decided by the user. 

 

 

Like transits, the date and time are changed.... 

• with the calendar in the Date and Time Navigator panel. 

• by clicking on the date in the center. 

• with the arrows and the H, M, S keys. 
 

 

 

 

 

 

 

 

 

Go to:  Main menu, Overview  
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How to do a synastry (SY) 
 

To get a synastry (juxtaposition and comparison of two themes), you just need to open a second theme in the middle 

wheel. With a natal theme open in the inner wheel, click on the SY button in the main menu. Mastro will open the Open 

a Chart window to select and load the chart into the middle wheel. The set of orbs used will be automatically adjusted 

to Synastries (SYN). 

 

Otherwise, if you open a chart in the middle wheel, using the Open Chart button in the middle panel, Mastro will 

consider it a synastry. The set of orbs used will be automatically adjusted to Synastries (SYN).  

   

  

If you want to change the set of orbs used, click on the button Use orbs.... This choice will remain active until you click on 

a method button (transits, progressions, ...) or click on New Chart or Open Chart for that wheel. For New Chart and Open 

Chart for the middle or outer wheel, the set of orbs will always be automatically adjusted to Synastries (SYN). 

Note that you can adjust the orbs in the Aspects tab of the Preferences. If you are using midpoints, you can also adjust 

the midpoint orbs in a synastry context (Tools menu, Preferences item, Midpoints tab). 

 

 

 

 

 

 

 

 

Go to:  Main menu, Overview  
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How to calculate the primary directions (PD) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Go to:  Main menu, Overview  

  

• Methods: The Primary Directions are offered according to the methods of Ptolemy 
(semi-arc), Placidus (under the pole) and Regiomontanus. 
 

• Directions: Directions can be calculated according to the ecliptic (In Zodiaco) or 
according to the equator (In Mundo).   
 

• Motion: The motion of points (planets, angles, or other points) can be direct (D-->) or 
converse (C-->). 
 

• Key: The key is a step measurement of the movement of a point. The following steps 
are available: Ptolemy, Naibod or Cardan. 

 

• Promissory: this is the point that moves (in one direction or the other) towards the 
Signifier.  A moving point can also be the place (degree) where an aspect occurs. 

 

• Significator: It is a point that signifies an area of life. A fixed point. 
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How to make a solar return (SR) 
 

Click the        button on the menu bar to open the Solar Return window. If necessary, change the location of the return 

and choose the year of the return then click on the Calculate button. 

 

 

  

If you check the Show options box, you can choose to calculate the return considering the precession of the equinoxes, 

but also, to keep the natal planetary positions of the inner wheel by producing the return in the middle wheel. These 

choices will be kept, and you can remove the check mark to get a simplified interface. 

  
 

 

Go to:  Main menu, Overview  

 

If you choose to place the solar return in the 

inner wheel, the natal positions will be 

replaced by those of the solar return. In this 

case, if you want a second return (another year 

for example), you must reload the natal chart 

in the inner wheel since this wheel now 

contains the solar return. To retrieve the 

previous natal data, you can use the drop-

down menu in the Inner panel, to recall the 

natal chart, otherwise click on the Open Chart 

button in the Inner panel or in the File menu or 

in the Context menu). 

 

Click the Change Location button to change the 

location of the solar return. 

 

Click on the Birthplace button to adjust the solar 

return location to the birthplace. 
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Navigation in time  
 

On the active chart, you can navigate through time by using the keys on the keyboard (up, down, right, and left arrows), 

by clicking a date on the calendar (Date and Time Navigator in the left panels) or by clicking on the date in the center of 

the inner wheel. The hours, minutes and seconds can be adjusted by clicking on the hour in the center.  The hours, 

minutes and seconds can also be changed with the H, M and S keys. 

  

   

 

 

With the middle wheel active, changes in date or time dynamically display planetary positions for transits, secondary 

progressions, or some other method. The natal chart in the inner wheel is usually static, but if it is active, the date and 

time of the natal chart in the inner wheel can be changed without creating a new chart.  

When displaying transits in the middle wheel (by clicking T on the menu bar), Mastro sets the middle wheel chart as the 

active chart, the chart on which the keyboard arrows cause a date change and the planetary positions for that date to 

be updated.  

With a chart in the middle wheel, if you want to act on the natal chart (inner wheel), you must tell Mastro that the 

active chart is the one in the inner wheel by clicking on the appropriate command button (icon): 

 

 

 

  

Go to:  Main menu, Overview, The panels on the left of screen   

Active planets and houses (inner, middle, or outer ring) : 

• on yellow background: active chart.   

• on a transparent background: chart not active. 
 
 

When there is no data in the middle wheel, the active chart 

is the one contained in the inner wheel. 

. 

Date - Inner, Middle, or 

Outer chart 

Time - Inner, Middle, or 

Outer chart 

 

Note: If you right click the mouse on the date in 

the center you have access to the Display options 

for the date and time. 

 

See Keyboard Shortcuts in the Help menu. The 

Ctrl key is usually used in combination with the 

keyboard keys to move forward in time for 

hours, minutes and seconds, but with the arrows 

they change the unit of time (e.g., days vs. 

weeks, vs. months). 

 



27 
 

Mastro - User guide - v.7.7 (May 2025) 

Date and Time Navigator 

 

The Date and Time Navigator panel, with the panels on the left side of the screen, contains a Gregorian calendar. 

 

 

 

 

 

 

 

 

 

 

Mastro uses a proleptic Gregorian calendar, which means that the dates before October 15, 1582, are considered an 

extension to the past of the usual Gregorian calendar, the one used in most American and European countries. (See 

Wikipedia: Proleptic Gregorian calendar ) 

 
To convert from Julian to Gregorian or Gregorian to Julian use the Date Conversion (Julian and Gregorian Calendars) 

item in the Tools menu. 

 
 
 
 
 
 
 
 

 

Go to :  Main menu, Overview, The panels on the left of the screen, Date Conversion (Julian and Gregorian Calendars)  

A few buttons on the right side of the panel allow you to set 

a date for a possible reminder during the session. 

If you click on a button without a date entry, the current 

date and time will be displayed on the button. 

If you click on the same button (displaying a date), Mastro 

will calculate and display the planetary positions at that 

moment for the active ring. 

A contextual menu offers: 

          

   

 

Now button (Ctrl + N).  

Calculates and displays 

the positions for the 

location signified by the 

active chart and for the 

current date and time. 

 

 

By clicking on the button with the month 

and year, the calendar will show you the 

months of the selected year, and then 

the years if you click on this button 

again.  

 

The arrows, to the right and left of the date, allow you to go to the previous 

month (left) or the next month (right) 

 

If you enter a year in 

this field, you must then 

click on BC (before year 

1) otherwise click on AC 

(year 1 and following). 

There is no year 0. 

 

https://en.wikipedia.org/wiki/Proleptic_Gregorian_calendar
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Modify Date 

  

 

 

 

 

  

When the outer wheel contains a chart and the Change Date window is called up, a check box is added to indicate that 

you may want to synchronize the date and time of the middle and outer charts.  

For example, one would like the transits in the middle wheel and the tertiary progressions in the outer wheel to be 

synchronized and that when the date of the active outer wheel is changed, the transit data in the middle wheel is 

automatically adjusted to the same date. Otherwise, the middle and outer wheels are independent as to date and time. 

A small padlock will appear at the top of the Middle Chart Info and Outer Chart Info panels (panels on the right). 

 

 

 

 

 

Go to : Main Menu, Overview, Navigation in Time, Display Option for Date and Time  

  

Now button (Ctrl + N).   

Calculates and displays the positions for the 

location signified by the active chart and for the 

current date. 

 

 

If you right-click on the date in the center (or the 

date in a moving panel) the context menu will offer 

you the Display options for date and time.  

 

When the outer wheel contains a chart and the 

Date window is called up, a check box is added to 

indicate that you want to synchronize the date and 

time of the middle and outer charts.  

For example, one would like the transits in the 

middle wheel and the tertiary progressions in the 

outer wheel to be synchronized and that when the 

date of the active outer chart is changed, the transit 

data in the middle chart is automatically adjusted to 

the same date. Otherwise, the middle and outer 

charts are independent as to date and time. 

A small padlock will appear at the top of the Middle 

Chart Info and Outer Chart Info panels (panels on 

the right). 

See : Synchronize the date and time of the middle 

and outer charts 

Date 

format 

 

 
Go to a 

date …   
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Modify Time 
 

When you click on the time (in the center, in a floating panel, or in the panels on the right) you get the following 

window. You can change the hour, minutes, and seconds directly, or click on one of the buttons in the window:  

 

• 0 h adjusts the time to 0 hours of the current date, then the cursor is placed on the Ok button. 

 

• Noon adjusts the time to 12 PM of the current date, then the cursor moves to the Ok button. 

 

• Adjusts the time to the moment when the Sun is in conjunction with the Asc. and closes the window. 

 

• Adjusts the time to the time when the Sun is in conjunction with the Mc. and closes the window. 

 

• Adjust the time to the moment when the Sun is in conjunction with the Dsc. (Descendant) and closes the 

window. 

 

• Sets the time to the moment when the Sun is in conjunction with the Ic. (Imum Coeli) and closes the   

window. 

 

• Displays the current time, then the cursor moves to the Ok button. The equivalent key on the keyboard is: 
Ctrl + N. 

 
 
Note: The button Time of the Sun's conjunction with the Fc may lead to the previous or next day depending on the 

current time. If this is the case, make the correction manually by moving to the next or previous day using the calendar 

or the ⇦ or ⇨ keys (left and right arrows). 

 

 

 

 

 

 

 

Go to: Main menu, Overview, Navigation in Time  
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How to display the aspects 

 

Note that to display the aspect lines correctly, the chart style must be set to European (Houses and Zodiac panel).  

To view all aspects, you must click on Show All Aspects           .  

To see the aspects that a natal planet makes to the other planets in the inner (natal) wheel, place the mouse cursor over 

the natal planet. This will display, in the center, the information about this planet: longitude and latitude. The aspect 

plot will be done for the aspects that the planet under cursor makes to the other planets or angles of the Inner (natal) 

wheel. 

The aspects, by default, are made from the outermost active chart to the natal chart of the inner wheel. 

When in the middle wheel, you have planets in transits, progressions or calculated with another method, the aspects 

are made from the middle wheel to the planets and angles of the natal chart (inner wheel). With data in the middle 

wheel (active), if you want to get the aspects that a natal planet receives, hold down the Ctrl key and place the mouse 

cursor over the natal planet. 

When in the outer wheel, you have planets in transits, progressions or calculated with another method, the aspects are 

made with the planets and angles of the natal chart (inner wheel). With data in the outer wheel (active), if you want to 

get the aspects that a natal planet receives, hold down the Ctrl key and place the mouse cursor over the natal planet. 

You can activate the Orbs and Aspects toolbar from the Tools menu under Toolbars to get more options with aspects. 

 

 

 

 

Mastro, by default, when the Show All Aspects button is clicked, displays the aspects from the outermost active chart to 

the natal chart of the inner wheel. This default can be changed by clicking on the drop-down menu to the right of the 

Show All Aspects button in the main menu. In addition, you can choose to clear the interpretations each time you redo 

Show All Aspects. This last feature is also available under Options for Interpretations. 

  
See also the Dynamic Aspectarium to draw aspects by composition (adding/removing aspects). 

 
 

 

Go to : Main menu, Overview, Search for aspects, Dynamic Aspectarium 

All aspects of the inner 

chart (natal) 

 

All aspects of the middle 

chart 

 

All aspects from the 

middle chart to the 

inner chart (natal) 
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Inner, Middle and Outer panels 
 

The Inner, Middle and Outer panels are identical in appearance, but the controls they contain act on their own wheel. 

The Inner panel is connected to the inner wheel that usually contains the natal chart. You can also observe (in the inner 

wheel) the current positions of the planets (Ctrl + N) or those at another date, by clicking on the date in the center or on 

a date in the calendar. 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

   

                                                                                           

 

 

 

Go to: Main menu, Overview, The panels on the left of the screen  
 

New chart button. 

 

Button Planets and houses 

active. 

 
Show houses button. 

 

On the header: The method (tr, ps, ...), the date and 

time. 

 

Open or close the panel. 

 

Hide the planets in this wheel. 

 

If you check the box Harm. ... an input field opens and allows 

you to enter the desired harmonic value. After entering a value, 

press the Enter key or click with the mouse in an empty space. 

 

 

The Bio button 

leads to a web 

page (source or 

relevant 

information) for a 

topic taken from 

the public 

database. 

 

The drop-down menu 

allows access to the last 

charts consulted during 

the session.  

 

The Change Location button opens the Change 

Location window and tells you about the current 

location if you hold the mouse cursor over it. For 

example: 

 

  

The Use orbs button allows you to adjust the 

orb set to be used. 

 

Mastro automatically selects the orb set to 

use according to the method. The inner 

chart is adjusted to the Natal orb type 

(NAT). A transit in the middle ring will be set 

to Transit (TRA). However, if you open a 

chart in the middle ring with Open Chart 

(middle wheel), then the orbs will be set to 

Synatries (SYN). 
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Houses and zodiac 
 

  

 

 

 

 

 

 

 

 

 

 
Go to: Main menu, Overview, The panels on the left of the screen  

  

Houses: drop-down menu offering a choice of house system. 

Left-Asc.: Ascendant to the left or Aries to the left (Left-Aries). 

Full line: displays the line of houses from the wheel center to the 

outer circle. 

Zodiac: Choice of tropical, tropical with precession or sidereal 

zodiac. 

Ayanamsha : F.Bradley, Lahiri, …  

Hide sign : Hide the signs of the zodiac. 

Reference plan : Choice between Ecliptical (default), Equatorial or 

Horizontal (Azimuthal). 

System : Choice between Geocentric (default), Heliocentric. 

Subdivisions :   

 

Chart style :  

• European (allows to trace aspects). 

• American  

• Dial 90 (Ebertin style) 

• Vedic (Jyotish) 

 

 

Choice of the house 

system. 
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Astro Events 
   

  

 

 

 

 

 

 

       

                                                                                        

 

 

 

 

 

 

 

Go to : Main menu, Overview, The panels on the left of the screen   

If you open the Astro Event panel, you can: 

• Find any planetary return in transit (i.e., a conjunction of a planet to itself) or the exact moment when a 

particular transit aspect occurs with any point on the natal chart (inner wheel). You can go to any phase by 

clicking on the right or left arrow.  You can also choose Progress from the angle drop-down menu. 

• Go to the previous or next lunar phase (if you right click on one of the arrows, you can determine which phases 

to include in the cycle) 

• Go to the time of day when a point is on an angle. 

• Go to the stationary moment of a planetary movement (previous or next) for any planet (All) or for a specific 

planet.  

 

 Right-click the mouse over the Previous 

or Next controls (yellow arrows) to 

select the phases to include in the cycle. 

 

To activate the controls in the Transit to Inner Chart frame 
of the Astro Events panel, you must click on the T control to 
display the transits (menu bar - Middle section).  
 
For the case Sol - 0° - Sol (Solar Return), if you click on the 
Previous arrow, Mastro will look for the previous Sun on the 
middle charts, i.e., the last transit of the Sun, at an angle of 
0° (conjoint) with the Sun of the inner wheel (natal chart), 
i.e., the solar return preceding the current date of the 
calendar. 
 
For a lunar return make the choice of the 0° Moon in the 
drop-down menus.  
 
 

Note on solar, lunar, and planetary returns: 

There is also a menu command         to calculate a solar return.  

With the Expert version of Mastro, it is also easy to use a drag and drop of planets on another to get the desired return 

(conjunction) or any other aspect between the two planets involved.  
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Midpoints 
 

The Midpoints panel displays the midpoints for the planet under the mouse cursor. The degree of the planet under the 

cursor may be halfway between two other planets (direct midpoint), or it may be at an angle of 135, 90, 45 or 22.5 

degrees from the considered midpoint (indirect midpoint).  

 

Orbs are adjusted in the Preferences on the Midpoints tab. Note that indirect midpoints at 22.5 degrees, while 

available in this grid, are neither in the midpoint trees nor displayed in the interpretations. 

 

You can also display the midpoints in transits on a natal planet. Place the mouse cursor over a natal planet while holding 

down the Ctrl key. If there is a transiting midpoint (direct or indirect) on the natal planet, it will be described in the 

Midpoints panel. 

 

 

 

 

Go to : Main menu, Overview, The panels on the left of the screen  
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Periods and Strengths for Inner Chart (Ashtakavarga, Dasha, Firdar, Almutens)  
 

  

           

                                                           

 

 

  

 

 

Go to : Main menu, Overview, The panels on the left of the screen  

Ashtakavarga (Force) is an Indian technique 

that establishes the planetary forces (from 

Sun to Saturn). 

A green line under a planet means that it is 

favorable in transit. A gray line means that 

its effect is neutral or not favorable. 

If you click on a planet in this frame, the 

points where the planet will exert its 

strength (green) and weakness (gray) or 

neutrality will be displayed on the zodiac 

circle... 

 

 

The Dasha period is 

displayed for the 

current transit or at 

progressed date. All 

periods are 

available by clicking 

All. 

 

The Firdar period is displayed for the current transit or progressed date. 

All periods are available by clicking All. 

 

In the Tables menu when one clicks  
Almutens, one is led to the window that 
displays the planetary forces according to 
this Hellenistic technique. 
 
The configuration options are available by 
clicking Options. 
 
Here, the Almutens are based solely on the 

essential dignities.  
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Dynamic Aspectarium 
 

 

 

   

 

  

 

 

 

 

Go to : Main menu, Overview, The panels on the left of the screen, How to display the aspects 

Aspects in longitude or latitude. 

 

Resonance aspects (if activated in the options 

and if there is an active chart in the middle 

wheel). 

 

To open the Options - Grid 

and Aspect List window  

 

Drop-down menu to display the inner, middle, outer, middle-inner, outer-inner, or 

outer-inner chart aspects, depending on the wheel displaying data. 

 

Reset and refresh the grid or aspect list. 

 

Print the grid or aspect list. 

 

Check to get the list 

of aspects. 

 

Choice of planets 

(Preferences 

window) 

 

To open or close 

the panel. 

 

Combined display 

of aspects and 

interpretations (full 

height panel) 

 

Dynamic Aspectarium - Single chart grid 

(triangular shape) (Ex: Natal chart) 

 

Dynamic Aspectarium - Grid between two 

charts (rectangular shape) (Ex: Transits chart) 

 

Dynamic Aspectarium - List 
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Dynamic Aspectarium - Full Height Mode 
 

 

                      .                         

 

 

 

 

 

 

 

 

Go to: Main menu, Overview, The panels on the left of the screen 

Combined display of aspects 

(in the form of a grid) and 

interpretations. The grid for 

one wheel takes a triangular 

shape and for two wheels a 

rectangular shape. 

 

Combined display of aspects (as a list) and 

interpretations. 

It is possible to expand the list by clicking between the 

two sections while holding down the left mouse 

button. 

You can click on the title of a column to order the 

items in the list according to the column. 

 

 

Return to normal 

display:  

 

To get the full height 

mode, when you are in 

the normal state, click 

on:   

 

The Options button 

opens the Options - 

Grid and Aspect List 

window. 

 

If you hold the mouse 

cursor + Ctrl over a 

box, you get the tooltip 

describing the object. 

 
 

 

• List (checked) 

• Grid (unchecked) 
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Dynamic Aspectarium - Options - grid and aspect list 

 

 

                       

 

 

 

 

 

 

Dynamic Aspectarium and aspect lines 

 

It is not recommended to use the Dynamic Aspectarium together with the "Keep aspect lines on screen" option (global 

context menu) because the aspectarium will not show the aspects you add to the chart by hovering the mouse cursor 

over a planet plus, if the interpretations are visible, as soon as the mouse cursor is removed from the planet, the 

interpretations thus added will be replaced by the aspects selected in the aspectarium grid or aspect list. 

 

A warning message appears if the xx option is enabled, and an attempt is made to open the aspectarium. This message 

can be disabled in the preferences on the Behavior tab. 

 

 

 

 

 

 

 

 

Go to: Main menu, Overview, The panels on the left of the screen 

 

Options for 

the Aspect 

Grid 

 

Options for 

the Aspect 

List 

 

Options for 

the Grid and 

the Aspect 

List 

 

Resonances 

configuration 

 

If you intend to modify the rules for a group of 

aspects (Identical Aspects, Harmonic Aspects, 

Dissonant Aspects or Custom Aspects), click 

this button to open the Rules for Resonances 

window.  

 

To adjust the Orbs for resonance 

aspects, click on Orbs for Resonances 

to open the Orbs for Resonances 

window. 
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Dynamic Aspectarium - Options - grid and aspect list - Resonance rules 

 

     

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

Go to: Main menu, Overview, The panels on the left of the screen 

 

A resonance aspect is an aspect that occurs in the mundane sky (middle wheel) between two planets while in the natal 

sky, these same planets also form an aspect (inner wheel). Note that transiting planets and natal planets do not 

necessarily form an aspect to each other. 

There are four groups of resonance aspects: 

• Identical aspects: the angle of the aspect between two natal planets is identical to an aspect between the 

same two planets on transit (same angle and same planets). Transiting planets do not necessarily make an 

aspect to the same natal planets. To add an identical aspect, it is necessary to enter the same angle in both 

fields and columns involved. 

• Harmonic Aspects: the angle of the aspect between two natal planets is harmonic and an aspect between the 

same two planets on transit is also harmonic (same family of aspects: for example, the trine and the sextile). 

• Dissonant Aspects: the angle of the aspect between two natal planets is dissonant and an aspect between the 

same two planets on transit is also dissonant (same aspect family: for example, opposition and square). 

• Personalized aspects: the angle of the aspect between two natal planets is identical, harmonic, or dissonant 

and an aspect between the same two planets on the transit is also identical, harmonic, or dissonant. 
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Dynamic Aspectarium - Quick Timeline (Transits) 

 

  

 

 

 

 

 

  

 

 

Go to: Main menu, Overview, The panels on the left of the screen 

When you click on an aspect, then right click, you get the 

contextual menu View Timeline for .... This menu is available for 

planets in transits only and in aspect to fixed natal positions.   

This choice opens a panel displaying: 

• Last date of entry 

• The last exact date 

• The last date of exit 

 

…  

The panel header displays the planet making the aspect, the 

aspect (angle), then the natal planet receiving the aspect. The 

current date is displayed in the center of the header and can be 

clicked to display the transits on that date.  

 

When you expand the previous panel, you get all the events for 

that transit. If you double-click a row, the transit chart will be 

displayed for that event. The rows with a yellow background 

represent the last three dates: Entry, Exact and Exit. 

The possible events are: Entry, Exact, Exit, Direct to Retrograde 

(D=>R) and Retrograde to Direct (R=>D). 

Note: The dates and times in the table are given in universal time. 

However, when you double click a row, Mastro calculates and 

displays the positions in local time. 

 

 

The circles represent the day of the entry date or the exit date. 

The diamond represents the day of the exact time of the 

appearance. 

The mouse cursor over the circles or the diamond displays a 

tooltip with the data. 

Note that Mastro will display? if an entry date, an exact date, or 

an exit date cannot be found within the time range scanned by 

Mastro (internal limits). 

NOTE: The quick timeline only works under the Aspects and 

Orbs by Angle configuration (menu Tools - Preferences - 

Aspects) and only for transits. 

 

 

Example of Uranus 120° Jupiter 

in transit: 

Enter: on March 28, 2023,  

Exact: April 23, 2023 

Leave: May 15, 2023 

Leave: January 7, 2024 (is retro 

and crosses the exit point again) 

 

 

You can expand 

the panel by 

clicking on the 

button with the 

down arrow. 
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Aspects scan 
 

To perform a scan, you must select a Start Date, a Duration and choose in the Options, the planets, aspects, and methods 

to include in the scan. You can check the Keep items box if you want to add items to the current list with a new scan. 

 

   
 

  

 
 

 

 

Go to: Main menu, Overview, The panels on the left of the screen 

Starts the scan 

 

Double clicking on a line displays the event (transit or other) in 

the active wheel (Middle or Outer). 

If you right-click on a row, a pop-up menu offers you the 

choices: 

 

Closes the scan panel 

 

Opens the Scan Options window 
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Aspect scan - Options 
 

 

Under the column Type in the scanning grid, you will find the following abbreviations: 

• TR : Transits  

• SP:  Secondary Progressions 

• PSA : Progression or direction of ascendant and MC on natal positions (planets and houses) 

• SA : Solar Arc Directions 

• TP1 : Tertiary Progressions (Type I) 

• TP2 : Tertiary Progressions (Type II) 

• PD : Primary Directions (aux angles) 

• D->R : Direct to retrograde 

• R->D : Retrograde to direct 

• SITR : Sign-Ingress-TR  (Sign Ingress for transits) 

• HITR : House-Ingress-TR  (House Ingress for transits) 

• SISP : Sign-Ingress-SP  (Sign Ingress for Secondary Progressions) 

• HISP : House-Ingress-SP  (House Ingress for Secondary Progressions) 

 

Go to: Main menu, Overview, The panels on the left of the screen 
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Forecast curves.  
 

The functions offered for the Forecast Curves are accessible through the Tools menu or by using the Curves toolbar. 

  

What are Forecast Curves?  

It is a navigation tool (browser) allowing to identify briefly the most significant moments in a time interval chosen by the 

user and in various themes expressed by keywords. To create the curves, the numerical ratings of about sixty various 

primary features are calculated for several consecutive transit themes and plotted over time. Each point of a curve 

summarizes the complete analysis of a transit chart in a specific theme expressed by a keyword. 

Significant moments are identified by observing the main (highest) peaks of a curve. 

To optimize the efficiency of the curves, an experiment on several hundred cases leads us to include the mid-points in 

this approach and to choose orbs of 1.32° for the aspects and 0.35° for the mid-points.  

 

 

 

 

Go to: Main menu, Overview, The panels on the left of the screen 
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Forecast curves - Create curves  

 

Before you can see curves, you must first create curves. To create curves, you must make certain entries and actions 

such as: 
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Select the chart for which we want to create 

curves. By default, it is the active chart in the 

inner wheel. 

.  

Change the location if the default location is not 

suitable.  

 

If you choose the From date and time to... 

option, you need to fill in the date and time 

fields in the From section and the To section. 

Then you need to enter two values in the Steps 

section, the quantity, and the unit of steps. 

If you choose the other option From date and 

time for n times, you must fill in the date and 

time fields in the From section. Then you need 

to enter the two values in the Step section. For 

example, if you want 2 readings per day, set the 

value to 12 and select Hours from the drop-

down menu. Finally, you need to fill in the 

Number of times field which will then be visible. 

The Description allows you to trace your curves 

in the list of curves in the View Curves window.  

... Then click Start. 

 

 

 

The Create Curves window will close, and you 

will see the counter at the bottom right of the 

screen indicating the number of completed 

readings. When the readings are complete, you 

will be notified by the message Forecast curves 

ready! 

 

In the Steps section, the Number of times field becomes visible 

with the From date and time for n times option selected. 

 

Counter indicating the number of completed readings 
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Forecast curves - View Curves or their Maximums. 

 

To access the curves, select a set of curves or a set of recent curves. To access the maximums for the curves, select the 

maximums for the curves or the maximums for the recent curves. 

 

A. See curves. 

 

• To view the curves from the list of forecast curve sets: 

 

o Via the Tools menu: Select Forecast curves - View Curves or their Maximums 

 

 
o Via the Curves toolbar (Tools menu - Toolbars - Curves) 

  

You get a list of the sets of curves produced up to now. In this window (View curves or their maximums) 

choose the set of curves to view and click View curves 
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To view the curves, double-click the desired item or select 

the item and click the View curves button.  
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• To see the latest curves (the last set calculated) 

 

o Via the Tools menu: Select Forecast Curves - View Latest Curves 

 

 
o Via the Curves toolbar (Tools menu - Toolbars - Curves) 

 

You are taken directly to the View curves window. 
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B. See Maximums for curves. 

 

• To see the Maximums for the curves from the list of forecast curves: 

 

o Via the Tools menu: Select Forecast curves - View Curves or their Maximums. 

 

 
 

o Via the Curves toolbar (Tools menu - Toolbars - Curves). 

 

You get a list of the sets of curves produced up to now. In this window (View curves or their maximums) 

choose the set of maximums for the curves to be viewed and click View maximums for these curves. 
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To view the maximums for the curves, double-click the 

desired item or select the item and click the Maximums 

for these Curves button.  
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• To see the Maximums for Latest Curves (the last set calculated) 

 

o Via the Tools menu: Select Forecast curves - Maximums for Latest Curves 

 

 
o Via the Curves toolbar (Tools menu - Toolbars - Curves) 

 

 

 

You are taken directly to the Maximums for Curves window. 
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Forecast curves - The View curves window. 
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One column for each 

chart of  

transits 

 

 

When you double-click a keyword in the grid, the 

background of the cell turns yellow. On the selected date, 

the bar in the histogram also turns yellow. 

 

If you double-click a bar in 

the histogram, it turns 

yellow and the box 

corresponding to that day 

and word in the grid also 

turns yellow. 

 

A list containing all the keywords selected in the period under 

review. If you double-click on a word, the graph for that keyword 

will be displayed. 

 

The Settings allow 

you to configure 

the appearance of 

the graph 
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Forecast curves - View curves - Zoom on the graph. 

 

It is possible to zoom in the graph: 
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Left click and hold the mouse button, drag the 

cursor to the target point and release the left 

mouse button. 

 

To return to the previous zoom level, click the small 

circle at the bottom left of the graph. 
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Forecast curves - View curves - Keyword signature. 
 

You can get the signature of a keyword by expanding the column for which you want more information. 

 

 

 

Forecast curves - View curves - Return to a chart for a specific moment. 

 
It is always possible to return to the transit chart for a specific moment by right-clicking on a bar in the histogram and 

choosing See the chart at this time. The same thing can be done in a keyword box by using the contextual menu. 

 

  

Choosing View chart at this time brings us back to the main window of Mastro Expert and makes the transit in the 

middle wheel appear. You will be offered to open the natal chart associated with the curves in the inner wheel if the 

active natal chart is not the one with which the curves have been constructed. 

When you select View chart at this time, the histogram window appears to close. In fact, it only minimizes itself in the 

taskbar to make room for the observation of the natal and transit charts. To bring it back to the foreground, position the 

mouse cursor over the Mastro icon in the taskbar and select the View Curves - (name of curves) window. 
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Forecast curves - Data mismatch.  
 

If the parameters used in the calculation of the curves are different from those used in the inner or middle wheel, when 

viewing a chart, a window will notify you of the differences.  

 

This information is only a warning and does not force any changes. It simply tells you that if you plot all the aspects and 

do an analysis with different settings than when you recorded the curves, then you may get different keywords or 

ratings in the analysis because the transits are not on the same chart (inner wheel) or do not make the same aspects. 

Here are some factors of mismatch: different choice of planets, different chart and zoom level, modification of orbs or 

visibility of an aspect in the Preferences since the recording of the curves. 
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Forecast curves - The identification of significant moments in a curve. 

 
It is important to understand the importance of placing a transit in its temporal context over a long period of time and 

not to be satisfied with a one-time reading. Not only are the Forecast Curves a predictive tool but they are also a 

research tool because they also provide ipso facto the control group, we need to judge the quality of a transit. Indeed, 

in the case of an accident, for example, all the days of the period considered when there is no accident constitute the 

control group.  

There are simple rules for assessing the size of a peak. Experimentation on a few hundred observations has shown that 

events tend to occur in application 4 days before a peak and in separation 3 days after. Thus, each peak has a time orb 

and represents a range of about 7 days. Another simple rule of thumb is to consider that if a peak is not in the top 5 in a 

year, it does not mean much anymore: indeed, 4 X 7 = 28 days out of 365 days represent about 8% probability of 

obtaining a predictive success by pure chance. 
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Forecast curves - View Curves or their Maximums - Curve properties. 
 

In the View Curves or their Maximums window select the set of curves for which you want to view the properties. The 

properties of a set of curves show the Mastro configurations at the time the curves were created. 
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Click on Properties to open 

the Properties window for 

a set of curves. 
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Forecast curves - Maximums for curves. 

 
The Maximums for Curves window displays the maximum ratings for each keyword. This allows you to see at a glance 

the important moments for all the curves. 

For each keyword, the data are arranged in columns according to their rank, i.e., the first column contains the first 

maximum (1st rank), the second the second maximum (2nd rank), etc.  If you click a cell to the right of a word, it will 

turn dark yellow. The other yellow cells have the same date or a date within 5 days of that date. The darker the shade of 

yellow, the closer the date is to the selected date. 

 
At the bottom of the window, you have the following information and controls: 

• Show - Date, Time, and Score: When the boxes are checked, each cell includes the information that has been 

checked. The "Date +/- 5 days" box shows the yellow boxes that are plus or minus 5 days from the selected date.  

• Display order (Date and Score): When you check Date (Score) or (Score) Date, then the date and the score, 

within the same cell, will be arranged according to your choice. This also assumes that Date and Score have been 

checked. This allows you to order the data in a column by date or by score, depending on whether you put the 

date first or the rating first. The order of the data in a column is established by clicking on the column header. If 

you click more than once on the header, the order will be descending or ascending. By default, the grid is sorted 

by the First Rank column. The second column shows the mood by color where green is favorable or the red one 

is unfavorable. 

• Data under cursor: the data changes as the mouse cursor passes over a cell. You get the keyword, the date, and 

the score. 

• Highlight a date: you can display in yellow the cells that have the date you enter and the dates more or less than 

5 days from this date, if you have checked the box Date +/- 5 days. You must click on the Highlight button to 

proceed with the search and display of the entered date. 

• Keyword to submit to GPT: If you select words (check the box), you can submit them to GPT to produce a text 

that will consider the context according to the instructions given to GPT. This button calls the window which 

allows the adjustment of the parameters of the conversation with GPT. 
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Forecast curves and maxima – combined windows 

You can combine curves and their maxima from the curves window: 

 

 

 

 

If one of the 2 windows (Curves or Maximum) is minimized, an orange button appears in the top right-hand 

menu. This button returns the windows to the main screen.
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Open Maximums from 

this button 

Restores minimized 

windows to service. 
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Interpretation tools 
 

Interpretation tools - Interpretations, Analysis and Synthesis 
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When you open the Interpretations, Analysis and Synthesis panel, 

you can read the interpretations for each of the factors as 

keywords on the Interpretations tab. To clear the interpretations, 

click Erase. Interpretations are displayed cumulatively, i.e., each 

time the mouse cursor touches a planet, its interpretation is added 

to the previous interpretation. To change this behavior, press Ctrl 

+ K (toggle) or click Options to bring up the Options 

(Interpretation, Analysis and Synthesis) window and uncheck 

Keep interpretation (when mouse over a planet). It is useful to 

keep the interpretation if you want to analyze more than one 

aspect figure at a time or the whole theme. It is often more 

convenient to enlarge the Interpretations, Analysis and Synthesis 

panel by double-clicking on the free band at the top of it or by 

clicking Displaying interpretations in full height mode.  

   

The Interpretations, Analysis and Synthesis panel can be opened 

to display the interpretations for the Radix. Mastro displays 

keywords for combined factors i.e., planets in both signs and 

aspects. These natal factors are identified by the inscription 

(natal) in the Interpretations tab. By placing the cursor on a 

transiting planet, you will get the transit keywords identified by 

the inscription (evnmt) meaning event interpretations.    

 

The Ctrl + K key combination toggles between Keep Interpretation and Delete Previous Interpretation each time a new 

aspect is drawn. 

The Z key deletes all the interpretation texts in the Interpretation tab. 

The X key expands the interpretation panel to full screen height or reduces it to its usual size. The same effect is 

obtained by double-clicking on the top band of Interpretations, Analysis and Synthesis or by clicking Displaying 

interpretations in full height mode. 

 

 

 

 

Delete interpretations 

 
 
Draw all aspects 

 
 Submit keywords to GPT 

 

 

  

 Options 

 
 
2 levels analysis (words grouped by theme) 

 
   

Quick analysis 1 level 

 
 

If you check this box, the aspects related to a clicked word will be displayed. 
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Mastro Expert can do the probabilistic classification of several hundred traits associated with an astrological 

chart and provide an analysis report. 

To carry out a complete Analysis-Synthesis of all the keywords displayed or only of those that you select in 

Interpretations, click on Analysis. The Synthesis tab will be enabled by default and will display a tree with 

primary traits and secondary traits. The primary keywords appear in the tree in descending order of 

importance. Secondary words have an order based on the size of their signature; they appear below the 

primary words to give them context. Each keyword in the tree is justified by an accompanying astrological 

signature (at the top of the tab). 
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Interpretation tools – Interpretation options     
 

The Interpretation Options allow the adjustment of several parameters. The Interpretations Options window is 
activated by clicking on the Options button in the Interpretations, Analysis and Synthesis panel.  
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• Check Keep interpretation… to keep the interpretation in the Interpretations 

tab (Shortcut: Ctrl + K). 

• Check Show aspect interpretation, show natal midpoint interpretation, show 

event midpoint interpretation to include their interpretations. 

• Check Show scores (Synthesis tree) if desired. 

• Check Show tooltips for a brief description of planets, houses, and signs. 

• Check Interpretation: automatic scroll down to bring the cursor to the end of 

the interpretation block. 

 

The probabilistic criteria controlling 
the presence of a word in the tree are 
controlled by the Filters in Options. 

Analysis filters affect the number of 
primary words and the number of 
secondary words in the tree. The 
higher the filtration, the lower the 
word count. 

To describe the aspect, the signature will 
use either: 

• A glyph 

• Degree notation 

• A letter: 
o C = Conjunction 
o H = Harmonic 

o D = Dissonant 

We can force the use 
of natal or event 
interpretation texts. 
Mastro returns this 
choice to Auto with 
each new session. 

Four text color 

choices for 

midpoint 

interpretations. 

Six text color 

choices for 

interpretations 

of direct 

midpoints. 

Background 

color of the 

Interpretations 

tab 

Planetary dominance 

(Godbout-Coron method): 

Check this box to allow the 

automatic addition of 

interpretations for the 3 

dominant planets. The 

interpretations (signatures and 

keywords) will be added twice 

to those already present when 

you click on "Show all aspects." 
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Interpretation tools - Quick analysis 

 

As we have seen, the Analysis compiles all the words in the Interpretations window then groups these words 

according to an analogy criterion. We have also seen that this process produces a Synthesis in the form of a 

tree of words at two levels: the level of primary words which express the main meaning and that of 

secondary words which contextualizes the primary words. 

 

Quick Analysis does not consider analogy between words and does not group them. It therefore does not 

produce secondary words and the tree has only one level. 
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If you want to include only part of the factors in the Analysis-Synthesis, 

with the mouse, select in the Interpretations window the part of the text 

which interests you and click Analysis. The analysis will only be done on 

the selected portion of the text. By default, if no part of the text is 

selected, it is obviously the entire text that will be analyzed. You can also 

exclude some of the text you don't want by deleting it directly on the 

Interpretations tab: just select it and delete it with the Delete key on your 

keyboard. 

Midpoints can be included in the interpretation by clicking Options, then 

Show natal midpoint interpretation and/or Show event midpoint 

interpretation. 

Note: Avoid passing the cursor a second time over a planet because the 

keywords will be duplicated and distort the analysis. 

The Expand/Collapse control at the bottom of the panel unfolds the tree 

and displays the secondary traits that have an analogy link with the 

primary traits under which they are found. 

A drop-down menu to the right of the Print button offers the following 

options: Print signatures, Preview and Print chart. 
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Interpretation Aids - Numerical Ratings 

 

In both kinds of analysis, a numerical score is always obtained for each primary word. It is a mixed rating obtained by a 

combined measurement of the number of occurrences of a primary word and the probability of observing this number, 

given the frequency of the word in the total astrological corpus of Mastro. Thus, the higher the rating of a word, the more 

its presence in an astrological chart is improbable, rare, and therefore significant. 

Note that the score will not appear if you have unchecked the Show scores box in the Options. 

 

Interpretation Aids - Signatures 

 

If you click on a word in the tree, that word and its astrological signature will appear at the top of the panel. A word 

signature is a set of astrological factors that include that word in their meanings. For example: 

 

Imagination: (☉♈ 90°♆)(☽♓ 0° ♀)(☽♓ 120° ♆)(☿♈ 90° ♆)(♆♋ 90° ☉)(♆♋ 120° ☽)(♆♋ 90° ☿) 

                     (♆♋ 90° ☊)(♆♋ 90° M)(☿=♅/♆) 

 

If you click on a signature, you bring up the Factors and associated keywords window which displays all the factors of the 

signature accompanied by all their keywords. 
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Interpretation support tools - Saving the tree. 

 

If you right-click on the tree, you can save the tree of words with their signature in text or csv format (with or without 

signature as desired). The name of the proposed file is composed of the date, the hour, and the name of the place. 

 

Interpretation tools - Writing rules under the Interpretations tab 
 

V here is an example: The expression “☉♉ 120°♂ (0.32 natal): energy, strength, tenacity, determination, power, …” can 

be split as follows: 

 

 

 

 

 

 

Note that the appearance can be represented in glyph, degree or letter format depending on the choice made in the 

options (Options button in the Interpretations, Analysis and Synthesis panel). For the 3rd choice of format, the letters 

C, H and D respectively mean conjoint, harmonic, and dissonant. Generally, D (dissonant) is associated with 180°, 90°, 

45° or 135° and H (harmonic) is associated with 120° or 60°. The association between aspects and their type (harmonic 

or dissonant) is made in the preferences window (Tools menu in the Aspects tab, under the H / D column). 
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☉ ♉ 120

° 

♂ 0.32 Natal energy, strength, tenacity, … 

The planet 

that makes 

the aspect 

The sign of 

the planet 

making the 

aspect 

 

The aspect The 

planet 

receiving 

the 

aspect. 

The Orbs 

in degree 

decimal 

Natal (natal) or 

event-based 

(evnmt) 

interpretation 

The keywords for this 

factor 

In Options (Interpretations, Analysis and Synthesis) 

you can choose the Glyph, Degree, or letter format. 
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Interpretation tools – Tooltips 
 

To show tooltips with keywords for planets, signs, and houses, open the Interpretations, Analysis, and Synthesis panel, 

click the Options button, and check the Show Tooltips box. 

When the cursor is over a point such as the Sun, a yellow box with keywords (planet, sign, house) appears near the 

point. To make the yellow box disappear, simply place the mouse over it or hit the Esc key. There is no need to click in 

the box. If you move the cursor to another point, the first box will disappear, and another will form near the point under 

cursor. 
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GPT – Keywords to submit to a chatbot.  
 
A. To invoke the “Keywords to submit to a Chatbot” (also called an GPT agent) window, you must follow these steps 

(Interpretations, Analysis and Synthesis panel) - Also note that this window can be called from the Maximum for 

curves window: 

 

 

 

 

B. Follow steps 1, 2, 3 and 4 of the "Keywords to submit to a Chatbot" window: 
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1 – Show all aspects or 

select aspects on the 

Interpretations tab. 

2 – Do an 

Analysis or 

Quick Analysis. 

3 – Click on the “Keywords 

to submit to the GPT agent” 

button. 

Select the 

agent 

instruction. 

Select the 

keywords to 

submit. 

You can also 

use the 

context 

menu … 

You can select the agent 

(agent web page). 

When the instruction and at least one keyword 

will be selected, click on the button “Open the 

chatbot and press Ctrl + V in the query field” (… 

on the Web page) … See Next page… 

When the agent produces a text from the 

instructions and keywords, copy this text from 

the web page, then return to this window to 

click on "Paste the agent answer". 

You can get a report by 

clicking on the “View the 

Report” button. 

You can filter the instructions: Natal 

and others, Natal, Events. 

Click Anonymous for a report that does 

not use the natal chart name. 

To add an instruction, 

click on the “Add an 

instruction” button. 

To Modify or 

Delete an 

instruction, 

click the 

appropriate 

button. 

Right-click to 

get the 

contextual 

menu for 

choosing 

keywords. 
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GPT – The Chabot (webpage) 
 
Here is an example of a Chatbot, that of ChatGPT:
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When you arrive on the agent's page, do Ctrl + V in this field to copy the query built from the selections made in 

the "Keywords to submit to a Chatbot" window and which has been automatically placed in the clipboard when 

you clicked on the button "Open the chatbot and press Ctrl + V in the query field". 

The agent will respond to you with a text. Enter this text and place it in the clipboard (Ctrl + V). 

Go back to Mastro's "Keywords to Submit to Chatbot" window and click " Paste the agent answer ". 

Note that each chatbot can have, although similar, a different interface and a particular access. It is usual that the 

agent asks you to register with email and a password. As the LLMs (Large Language Model - GPT-3.5 for example) 

which underlie these agents are progressing rapidly, the interfaces are also subject to change. 

Also, the texts generated by these agents appeal to your judgment. 
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GPT – Add, modify, or delete an instruction to an agent. 

 

Depending on the command performed (adding, modifying, or deleting) the "Changing instructions to a 

chatbot" window allows you to make the changes. For an addition or a modification, be sure to choose the 

"natal" or "event" context and the tone of the conversation. 

Write your questions in a way that allows Mastro to rephrase your instruction to make it anonymous or 

personalized with the name of the inner chart wheel. For example, if you want to formulate an instruction 

like "Make a quick portrait of John with the following keywords:", it would be better to write your instruction 

as follows: "Make a quick portrait of {this person } with the following keywords: » to allow the use of this 

formulation to other individuals while allowing the request to be made anonymous in the "Keywords to 

submit to a chatbot" window where you can check the box “Anonymous” or uncheck it when you want to 

customize the query. The "{this person}" and "{this individual}" buttons can be clicked to insert these words, 

where you put the cursor, in the text of the instruction. 
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Adjusted Planetary Dominance (Godbout and Coron) 

 
The dominant planets determined astrologically from the biographies are targets that should be reached by the 

dominant planets calculated according to rules determined solely from the astrological chart. This Planetary Dominance 

model was therefore developed by identifying the combination of astrological rules that allow us to arrive at the 

biographical dominance of many subjects solely from their charts. 

In practice, here is how the Dominance is calculated: 

  

 

For each planet and for each factor, when the rule is respected, a check mark is written in the corresponding cell. Then, 

the total score of the weights corresponding to the check marks is calculated vertically for each planet to rank them in 

order of importance. In the lower rectangle, the 1st series of numbers indicates the total score obtained for each planet 

and the 2nd series of numbers gives the percentages obtained by dividing each planet's score by the total of the scores. 

 

If you check the box Add 2 times (signatures)... in this window and click on Show all aspects (main menu bar, or main 

contextual menu), the three dominant planets are added twice each to increase their presence in the Interpretations 

window and in the two Analyses (rapid and complete). The box remains unchecked and must be selected each time you 

wish to add the dominant signatures to the current analysis. 

 

Notes: The five major aspects have the following orbs: conjunction and opposition (10°), trine and square (8°), sextile 

(6°). Only aspects of planets and angles are considered. The modern rulers and the Placidus houses are used. 

 

 

 

 

 

Go to: Main menu, Overview, The panels on the left of the screen 
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Chart list tab 
 

The Chart List tab displays the charts stored in your databases: User, Public, Tutorial, Client. 
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Onglet Liste des cartes 

This panel contains commands for selecting 

the database and chart types (natal, 

mundane and event) and allows you to 

display the selected chart or event by 

clicking on the name in the list. 

Event charts are first created with data in the 

middle wheel, then the natal chart and event 

chart are saved together by pressing Ctrl + E 

or by clicking Save Event in the main 

Contextual menu. 
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Lunar phases tab 
 

Moon phases are available for the years 1800 to 2100. When clicking on a row, if the option is activated, the selected 

phase is calculated (in world/transit position) and displayed in the active wheel. The phases available in transit only are: 

• the new moon ● 

• the first quarter ◖ 

• the full moon ￮  

• the last quarter◗ 
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Lunar phases tab 

 

Lunations option 

To open the Lunations option window click Options the Lunations tab. The options 

allow you to: 

• Adjust the date format. 

• Display the lunation on selection (left click of the mouse on the row) 

• Display a warning when the middle wheel is closed, saying that the 

selected moon phase will replace the natal chart in the inner wheel. 

Choice of the phases to be 

displayed. 

 

• Drop-down menu 

offering the possibility 

to display the phases 

for 1 or 2 years. 

• The left arrow allows 

to start a previous 

year.  

• The right arrow allows 

to start a next year. 

Note: the years always 

start on the 1st of January 

of the current year of the 

active wheel and cover the 

year or 2 years depending 

on what has been chosen. 
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Change location. 
 

When you open an existing chart or create a new one, Mastro will remember and use the coordinates you entered. 

         For transits (middle and outer wheel), i.e., when you click on the T icon in the top menu, Mastro uses, by default, 

the coordinates of the current location. You can change the coordinates of the transit by clicking the Change Location 

button. This way, you will set the transits, solar or lunar revolutions and lunations at the desired location. 

 

  

If you clicked on Choose Coordinates, you have the choice to link this city to an existing city in our city database to 

retrieve the time difference with GMT and the key (not visible) that allows automatic time changes linked to this area. 

After finding the latitude and longitude (internet search) and entering the values in the appropriate fields, you can keep 

this city in your personal city database. It will be visible in the list of all cities when you do a name search. Under the 

User data column, it will show "Y" (Yes). 
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You can quickly select the location from the 

following four choices:  

 

• The current default location (set in 

the Tools menu under Preferences).  

• The native coordinates (inner 

wheel).  

• The coordinates of a city.  

• Coordinates: latitude, longitude, and 

time difference with GMT. 

 

 

Click on the Change Location        command to 

change the location of a Transit, Solar Return 

or other. 

. 
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Use orbs. 
 

The Use orbs button, present in the inner, middle, or outer panels, allows the use of a set of orbs defined in the 

Preferences, in the Appearance tab. Mastro automatically selects the sets according to the requested planetary 

position calculation method. When opening a chart in the inner wheel, Mastro adjusts the orbs to Natal (NAT). For a 

transit, Mastro adjusts the orbs to Transit (TRA). The same is true for the other methods. It is possible to change the 

orbs to the desired set by clicking on the appropriate radio button for the inner, middle, or outer wheel. Each wheel is 

independent in its choice of set. 

 

Here is the table of Mastro's automatic choice for all the orbs. For example, if you click on the Profections button for 

the middle wheel, the orbs used to assess whether there are aspects between the planets in the middle wheel and the 

planets in the inner wheel (the natal chart) will be the orbs for Profections as set in Preferences. 

Automatic Orb Selection Chart :  

Wheel Function/Button Default Orbs 

Inner 
 New chart 

Natal 
 

 
Open chart 

Natal 

 
 Ctrl + N (Now) 

Natal 

Wheel Function/Button Default Orbs 

Middle and 
Outer 

 New chart 
Synastry 
 

 
Open chart 

Synastry 
 

 
 Ctrl + N (Now) 

Transits, SP, TP, …  (what was there before) 

 
 Transits 

Transits 

 
 Secondary Progressions 

Secondary Progressions  

 
 Solar Arc Directions  

Solar Arc Directions 

  Tertiary Progressions  Tertiary Progressions 

 
 Profections 

Profections 

 
 Symbolic Directions  

Symbolic Directions  

 

  

Go to: Main menu, Overview, The panels on the left of the screen 
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Toolbars 
 

To activate the toolbars, check the desired items under the Toolbars item on the Tools menu. The Curves and Orbs and 

Aspects toolbars are initially positioned above the panels on the right. 

 

Curves 

 

 

 

 

 

 

 

Orbs and Aspects 

 

 

 

 

 

 

 

 

Go to: Main menu, Overview, The panels on the left of the screen 

On the Curves toolbar you have, in order, the commands:  

• Create curves. 

• View curves or their maximums.  

• View recent curves. 

• Maximums for recent curves. 

• Select planets and angles (leads to the Tools menu in the Planets tab of the Preferences). 

The first 4 commands correspond to the items in the Forecast curves menu in the Tools menu. 

 

     

 

Under Orbs (and aspects) you have, in order, the commands: 

• % - If you click on the %, the ratio will be reset to 100%. For a ratio of plus or minus 100%, the color turns orange. 

• The percentage value (minimum 10% and maximum 300%) of the current orb values defined for each method in the 

Preferences. 

• All aspects between the planets and the angles of the inner ring (natal chart) according to the visibility of aspects defined 

in the Preferences. 

• All aspects between the planets and the angles of the middle ring (Transits, Progressions, ...) according to the visibility of 

the aspects defined in the Preferences. 

• All aspects between the planets and the angles of the middle ring and the planets and angles of the inner wheel (natal 

chart) according to the visibility of the aspects defined in the Preferences. 
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Planets 

  
 

 

 

 
Houses 
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The Planets toolbar displays the coordinates for the planetary positions.  

If you click on a planet, Mastro will display the aspects of that planet (toggle). 

If you right-click on a planet you can change the visibility of this planet. 

If you check 2 planets, you get the value of the angular distance between them displayed at 

the bottom of the panel. 

In the options (jagged icon) you have the choice to click more than one planet at a time. You 

can also adjust the presentation in degrees, minutes, seconds, or decimal degrees. 

 

The Houses toolbar displays the longitude in 360° notation or in degrees-sign-minutes. 

With the Mastro Expert version, if there is an outer chart, to display house values for outer 

chart. You may have to click on “Middle” (in the row) or “Outer”  to toggle between the set 

of values. 

You can choose to display the values for longitude, latitude, right ascension, declination, or 

azimuth (horizontal): 
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Angles 
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The Angles toolbar displays the angles between 

planets. 

PP display: shows the angle between natal planets 

or planet in transit with natal planets, (or PS, etc.) 

PP-PP display: shows the angle between planets on 

each wheel, by planetary pair (natal-natal), (transit-

transit), ... 

The angle is displayed in decimal degrees. 

Move the mouse over the scroll bar to reach the 

desired values. 

In the options, you have the choice of highlighting 

harmonic and dissonant aspects and highlighting a 

particular harmonic. 

You can select more than one row and copy them to 

the clipboard. 
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Search for aspect 

 

Search for an aspect from transits, progressions, directions (middle wheel) to a point in transits, progressions, directions 

(middle wheel) or to a natal point (inner wheel), using drag and drop to any degree or to a target planet. 

We can perform three types of searches by dragging the Sun, Moon, Lunar Node, or any planet onto a point. The target 

point can be the Sun, the Moon, a planet, an angle, or the North Node. It can be located on a natal chart in the inner wheel 

or on a chart of transits or progressions (secondary or tertiary) or solar arc directions in the middle wheel. 

Here are the three types of searches (you can replace "transit" by "progression" or "direction", "point" by "planet" or 

"angle" and "natal chart" by "inner ring chart"): 

a) Point in transit to a degree on the natal chart (approximate search for angle to natal degree) 

b) Point in transit to a fixed natal point (exact search of the aspect) (Mastro Expert only) 

c) Point in transit to a point in transit (exact search of the aspect) (Mastro Expert only) 

You can drag and drop a planet by clicking on it while holding down the left mouse button. Then we drag this planet to 

the target point and release the left mouse button.  

By default, the time direction is towards the future. To search in the direction of the past, hold down the Ctrl key when 

you release the left mouse button. You can obtain this result in another way, in the menu at the top right, by clicking on 

the arrow to turn it to the left for the past or to the right for the future. You can also select the desired angle between the 

two planets or points involved in the drop-down menu of angles, at the top right. 

The default aspect is conjunction (0°), but you can select the desired angle between the two planets or points involved 

in the angle drop-down menu at the top right. When the angle is different from the conjunction, the background color 

of the aspect drop-down menu becomes orange. 
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If you drag a planet on 

another one, the value 

of the angle sought 

between these 2 points 

is determined by this 

choice of angle. By 

default, the angle is 0. 

 

The arrow indicates the 

direction of time: right 

for the future, left for 

the past. Click on the 

arrow to change the 

direction. 
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a) Research of the moment when a planet in transits, in progressions (secondary or tertiary) or in solar arc 

directions arrives on any degree of the zodiac (approximate search for the angle to the natal degree). 

 

 

 

 

b) Search for the moment when a point in transits, in progressions (secondary or tertiary) or in solar arc 

directions (middle wheel) arrives in exact aspect with a natal planet (inner wheel), using drag and drop to 

the target planet (fixed). 
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This operation is available for transits in all versions of Mastro. Drag the 

planet (Sun, Moon, Node, or planet) to the desired degree. Mastro will 

calculate and display all transiting, progressed planets (secondary or tertiary) 

or solar arc directions at the moment the moved planet reaches this degree 

with more or less one degree accuracy. 

 

Available in the Mastro Expert Edition. Drag the planet (Sun, Moon, Node, 

or planets) in transits or secondary progressions onto the desired natal 

planet; for example, the transiting Sun onto the natal Sun (solar return).  

When the target planet becomes highlighted in yellow, release the left 

mouse button to get the chart of transits, progressions (secondary or 

tertiary) or solar arc directions, at the exact moment (usually within one arc 

second) when the event will occur (future) or has occurred (past) according 

to the time direction you have chosen. 

 

You can change the direction of time when searching. To go to the past, hold 

down the Ctrl key when you release the left mouse button. You can do it the 

other way around, in the menu at the top right, by clicking the arrow to move 

it to the left for the past or to the right for the future. This is a toggle control 

that will keep the direction of time until you change it. 

You can also change the aspect angle by selecting the one you want from the 

angle drop-down menu. For example, to get the solar half-return, set the 

angle to 180° before dragging the transiting Sun onto the natal Sun. 

 

Direction of 

time. 

 

Desired angle. 
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c) Search for the moment when a planet in transits, progressions (secondary or tertiary) or solar arc directions 

(middle wheel) arrives in exact aspect with a planet in transits, progressions (secondary or tertiary) or solar 

arc direction (middle wheel), using drag and drop to the target planet. 
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Available in the Mastro Expert Edition. Drag the transiting, progressed or 

solar arc directed planet (Sun, Moon, Node, or any planet) onto the desired 

(transiting or progressed) planet, for example, the transiting Sun onto 

transiting Mars.  When the target planet becomes highlighted in yellow, 

release the left mouse button to get the transits or secondary progressions 

chart at the exact time (usually within one arc second) that the event will 

occur (future) or has occurred (past) according to the time direction you 

have chosen. 

 

You can change the direction of time when searching. To go to the past, hold down the Ctrl key when you release 

the left mouse button. You can do it another way, in the menu at the top right, by clicking the arrow to move it 

left for the past or right for the future. This is a toggle control that will keep the direction of time until you change 

it.  

 

You can also change the aspect angle by selecting the one you want from the angle drop-down menu. For example, 

to find the next square between Mars and transiting Neptune, set the angle to 90° before dragging transiting Mars 

over transiting Neptune. 

Finally, note that all sliding operations from one planet to another or to a degree of the zodiac can only be 

performed on the inner wheel or between the middle wheel and the inner wheel in transits, in secondary 

progressions, in solar arc directions, or in tertiary progression mode only, in the ecliptic plane, in geocentric and 

in the European chart style (chart style is set in the House and Zodiac panel).  
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Create an event.  

 

When you press Ctrl + E while a transit or progression is displayed in the middle or outer wheel, you get the window 

that lets you keep an event linked to the inner wheel's natal chart. You can also link this event to a group. A group can 

be created by clicking the Edit Groups button.  

 

 

The events saved in this way can be found by clicking the Chart List tab under the name of the associated chart.  

  

 

Go to: Main menu, Overview  
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Select the charts in the Chart List tab. 
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By clicking on the Charts List tab, you will get a list of the 
charts you have already created (depending on the filter 
applied) including, possibly, the Event type charts that you 
create with the Ctrl + E key and that you can only open 
through this list. 
 

• Click + or - to expand the chart tree. 

• Select the database to get the list of charts included in 
this database. 

• Select All Charts, Apply Filters or Other. 

• Click Filters to adjust the filters. 
 
 

When you click on the Filters button in the Charts List tab, 
you can access this window where you can: 
 

• Filter according to All Event Charts, All mundane 
Charts, All Natal Charts or All Natal Charts, Mundane, 
and Event Carts 
 

• Filter the charts according to a group you have 

previously created (Edit groups button). To access the 

groups, check Use a grouping. The charts are put into 

groups (associated with a group) by clicking Combine 

Charts and Groups. 
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User interfaces 
 

 

If you change the interface, Mastro will ask you to reboot to reset its environment. 

 
 

The 3 possible interfaces are: 

• The Simplified with interpretations interface includes all the elements of the Dynamic Aspectarium and 

Interpretations, Analysis and Synthesis panels. 

 

• The Simplified interface keeps only the menus. 

 

• The Full interface includes all elements (buttons, menus, panels, or other objects) visible from the main Mastro 

window. 
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Request for interpretation   
 

In the Tools menu, the Interpretation Query item offers two query options:   

  

Interpretation query - Aspects or Midpoints => keywords. 
 

If the Midpoint option is selected, the window changes its appearance to show the midpoint in the form a=b/C.   

 

Query for an aspect: 

 

 

In case of a query for an aspect, choose a planet or an angle under Point A and Point B. Under Sign choose the sign. 
Under Natal or Event Keywords choose Natal or Event.  Under Aspect Type click on Conjoint, Harmonic or Dissonant. 
 
 

 

Go to: Main menu, Overview 
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Query for a midpoint 

 

In the case of a query for a midpoint, choose planets under Planet A, B and C. Under Natal or Event Keywords choose 

Natal or Event.  
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Interpretation query - Keywords => Aspects or Midpoints.  
 

You can search for one word, two words or three words at a time. For example: love AND grace AND prestige to further 

filter the signatures to remember. 

 

 

 
You can select the following aspect types: 
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Animation  
 

The animation functions can be accessed through the Tools menu: 

  

 

You can animate the movement of the planets according to the desired time unit (Second, Minute, Hour, Day, Week, 

Month or Year) and according to a certain step towards the past or the future. Click Start to begin the animation. You 

can stop the animation by clicking Stop or Close. 

If you first click Start and then click one of the two Manual Step buttons (left arrow or right arrow), the automatic advance 

will stop. 

You can reposition the animation window by clicking on a corner of the window. Hold down the left mouse button while 

dragging the window to the desired position, then release the left mouse button. The new position will be remembered 

and retained in subsequent Mastro sessions. 

Note that the movement will be accelerated if you keep the Interpretation, Analysis and Synthesis panel closed since 

Mastro will not have to make a series of interpretation requests at each step when it is not required to register the 

keywords. 

Go to : Main menu, Overview 
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Animation - keyword saving 
 

  

Here is how to use and generate the file Trees.csv or mastro_data.xls. First you must determine if you have only one 

chart (natal for example) that you want to move or if you have two charts (natal + transits, progressions, or directions). 

If you have 2 charts, what chart will move (transits in relation to a natal chart for example)?  Then you must go to the 

menu Tools > Animation and click on Animation, a floating window appears, and you must select the format for saving 

the data collected in the file Trees.csv (format Data - columns) or mastro_data.csv (format Data - Rows). Then you 

choose the units of increments and the number of these increments at each step (Unit and Step). Then you choose the 

total number of iterations in the # of time field. Then click Start. At the end you will have stored in a csv file a list of 

keywords with their signatures for each of the calculated charts. For data in columns, these lists are kept in the first 

column of the sheet (Excel) of the Trees.csv file and they are separated simply by empty lines. In the case of data in 

rows, they are kept on one row per reading (increment) and each keyword occupies one column. When the task is 

completed, you have the possibility to open the mastro_data.csv file by clicking on the Open Excel button. 

 

 

Go to: Main menu, Overview 

When you click the button that allows you to expand the 

animation window, you will see the function to save automatically 

the keywords generated at each step, in a file (Excel format) 

named mastro_data.xls or Trees.csv on your computer desktop. 

 

Set the number of iterations (how many times I move in a 

direction) 

 

Use the above data: The unit, The step (advancement in seconds, 

minutes, hours, days, ...) and the Direction. 

 

Data from a Csv file.   

 

Random data.   

 

Data arranged on a column or columns (file Trees.csv). The data is 

added at the end of the file. 

 

Data arranged on lines (mastro_data.xls file). At each startup, the 

file is overwritten. 
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Dates of Previous Transits at the Current Position 
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This window shows the dates when the planet under the cursor has been at 

the same place in the past. If you point to a natal planet, the dates of passage 

on the degree of this planet are between 1900 and the date of birth. For 

planets in transits, the dates indicated, in degree of the planet considered, will 

be those between the date of birth and the current date. The direction of the 

movement (direct or retrograde) is also displayed. The observed data are 

between 1900 and 2100. 

You can reposition this window by clicking on a corner of the window. Hold down the left mouse button while dragging 

the window to the desired location, then release the left mouse button. The new position will be remembered and 

retained in subsequent Mastro sessions. 
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Relocation 
 

From the Tools menu, select the Relocation item. You can vary the latitude and longitude and watch as the chart in the 

center conforms to the new data. This way you can bring a planet to a particular angle. When you get what you want, 

you can make a note of the coordinates or click on the button with the Google Maps position icon that will take you to 

the chosen location in your default browser. 

  

 

 

 

 

 

 

If your default web browser is Chrome or Microsoft Edge, you can drag and drop the browser address onto the Mastro 

application window. Here is an example of use on Windows 10 with the Chrome browser: 

 

1. Open the Chrome browser and type “google maps” in the browser bar and go to the Google Maps website: 
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Click this button to open your web 

browser to the Google Map page at the 

coordinates shown in this mobile panel. 

 

Click this button to return to 

the initial coordinates of the 

selected wheel. 

 

Check this box to get 

the coordinates in 

degrees, minutes, and 

seconds otherwise the 

coordinates will be 

displayed in 

degrees/decimal 

format. 

 

Check this box to display all 

aspects and their interpretations 

if the Interpretations, Analysis 

and Synthesis panel is open. 
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2. In the search bar enter the city for which you want to relocate the active chart... 

 

Assuming you enter "New York, USA", you get : 

 

3. Select the address bar that says "Secure | https..." by clicking the left mouse button. Then drag this address 

onto the Mastro icon in the taskbar at the bottom of the screen. When you are over the Mastro icon, Mastro 

expands. Then drag the address onto the Mastro surface and release the left mouse button. This will bring up 

the relocated chart. The relocation panel will be displayed if it is not already present. 

  

 

Go to: Main menu, Overview 
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Interchange data between two wheels 
 

Place the cursor on one of the panels (Inner, Middle or Outer) in a free area, and press the left mouse button. Holding 

down the left button, drag the cursor to the panel where you want to move the data. Release the left button under the 

desired panel. The data will then be swapped between the two wheels. For example, if you open a chart in the inner 

wheel and another chart in the middle wheel to do a synastry, you can then switch the positions of the two charts 

between the middle and inner wheels by dragging the mouse from one panel to the other.  

 

  

You can do the same operations using Swap charts… in the Tools menu. 
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Synchronize the date and time of the middle and outer charts. 
 
If the middle wheel and the outer wheel are present, the Time and Date windows present the option to synchronize the 

data for these two charts: 

  

To indicate this time synchronization between the two rings, the panels on the right, if they are visible, will have a small 

padlock in their upper right corner. 
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This lock can be clicked to set the date and time synchronization. Check the 

Use same date and time for middle and outer rings box to let the middle and 

outer rings be independent from each other. 

 

 

 Unlock (unchecked) - Independent Date and Time (Middle -Outer)  

 Locked (checked) - Same Date and Time (Middle -Outer) 
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Ephemeris 
 

The ephemeris is accessible through the Tools menu: 

 

The ephemeris allows you to display the planetary positions according to several criteria such as: time unit and step, 

calculation for the time zone of your choice (standard time only), tropical or sidereal zodiac in geocentric or heliocentric. 

After selecting the start and end dates as well as the different parameters, click Generate list to obtain the ephemeris. 

If you double-click a row, Mastro will display the planetary positions for the chosen date in the main window. 

 
 
 

Go to: Main menu, Overview 
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Transiting Midpoints Scan 
 

 

In the Tools menu, under Transiting Midpoints Scan, you can observe the midpoints in transits. To begin, adjust the 

start and end dates and other parameters and click on Update. When a multiple aspect of 45° to the radix (Natal) is 

present, the box appears in yellow. The observation can be done by theme (Love, Success, Effort) or in relation to a 

planet which is part of the midpoint in transit (Midpoint with ...).  

If you click the yellow box, an interpretation of the transiting midpoint will be displayed at the bottom of the window. 

Note that midpoints that contain a duplicate planet (e.g., ♃ /♅ = ♃) do not have a description. 

You can also get the midpoints in transits on a natal planet by pressing the Ctrl key while pointing the mouse cursor at a 

point (planet, Moon Node, angle) on the inner wheel. If the Midpoints panel is open, you will see the midpoints in 

transits.  

If the Interpretations, Analysis and Synthesis panel is open, on the Interpretations tab, you will see the interpretation 

(in Mastro Expert only). 
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Date conversion (Julian and Gregorian Calendars) 
 
Mastro uses a proleptic Gregorian calendar, meaning that the dates before October 15, 1582, are considered a normal 

continuation of the usual Gregorian calendar, the one used in most American and European countries. (See Wikipedia: 

Proleptic Gregorian calendar) 

 
For Gregorian to Julian or Julian to Gregorian date conversions, Mastro offers a conversion tool in the Tools menu, 

under Date conversion (Julian/Gregorian). 
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Entrez la date et 

cliquez sur la flèche 

pour obtenire la date 

grégorienne 

https://en.wikipedia.org/wiki/Proleptic_Gregorian_calendar
https://en.wikipedia.org/wiki/Proleptic_Gregorian_calendar
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Eclipses 
 

  

 

 

 

 

 

 

 

 

 

 
 

Go to: Main menu, Overview 

From the Tools menu, select the Eclipses 

option. 

1. First, choose the type and number 

of eclipses you want to calculate 

(solar or lunar). 

 
2. Then click on Solar Eclipses or Lunar 

Eclipses. 

You will get a list of eclipses that 

indicates the date and time when the 

eclipse is maximum and the type of 

eclipse. 

Note that the times displayed are given 

in Universal Time. 

 

 

 

Double click on the desired date and Mastro will display the positions of the planets in the active wheel chart (inner, 

middle, or outer), at the local time and location given. If you change the location, Mastro will use the local time, 

longitude, and latitude of the chosen location. 

 
The orbs used will be automatically set to Transits (TRA). 
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Tables 

 

Tables - Planetary angles 

 

 

 

The Planetary Angles table gives the value of the angles between each planet position and angle. 

It is possible to vary the orbs used and to highlight certain aspects. 

 

 

 

Go to: Main menu, Overview 
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Tables - Midpoints 
 

 

 

Displays each midpoint, its position (always in 1st harmonic), its Angle, With ... the natal planet if it participates in the 

direct or indirect midpoint, its Orb, and if this midpoint is in application or in separation with the planet. You can click 

on a column heading to order the list of midpoints. For example, you can first click on With, then on Angle to get the list 

of midpoints with the midpoints that are at 0°, 90° or 180° with a planet of the ring selected with the Aspect to points 

drop-down menu... If you click on a midpoint, the keywords for that midpoint will be displayed at the bottom of the 

window. 

 

Go to: Main menu, Overview 



97 
 

Mastro - User guide - v.7.7 (May 2025) 

Tables - Midpoint Tree 
 

 

 

 

 

  

Go to: Main menu, Overview 

Drop-down menu to select the 

ring. 

 

Check this box to display the midpoint 

trees, without considering the points 

that have been unchecked in the 

Preferences. 

 

Allows to put a point (planets 

or angles) in red and thus to 

facilitate its location in the 

trees. 
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Tables - Times of conjunctions (Planets/Angles) 

 

 

 
The table Times of Conjunction (Planets/Angles) gives the time when each planet is in conjunction with an angle. 
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Tables - Positions of the planets in the reference planes 

 

 

 

The different planes are a reference to the following celestial coordinates: Ecliptic (Ecl.), Equatorial (Eq.) and Horizontal 

(Hor.). 

 

External reference (Wikipedia): Celestial coordinate system  

 

 

 

Go to: Main menu, Overview 

 

https://en.wikipedia.org/wiki/Celestial_coordinate_system


100 
 

Mastro - User guide - v.7.7 (May 2025) 

Tables - Almutens 

 

 

 

The Almutens represent a system of planetary forces of Hellenistic origin. In its current version in Mastro, we use the 

classical method of calculation which is based on the essential dignities. Click on the Options button to configure some 

calculation parameters according to different authors. 
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Tables - Triplicities, Quadruplicities and Polarities 
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Tables - Speeds and Distances of Planets 
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Tables - Fixed stars 

 

 

 

Positions of some stars as well as their aspects in conjunction, parallel and counter-parallel with the planetary positions 

of the selected wheel. If you double click on a star and you are connected to the Internet, you get an English description 

of this star. Moreover, you have a link to the site http://www.constellationsofwords.com. 

 

 

 

Go to: Main menu, Overview 

http://www.constellationsofwords.com/
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Tables - Parallel and Contraparallels 

 

 

 

Parallels are aspects in declination that have the nature of a conjunction. They are measured from the equator. 

Contraparallels are in the nature of opposition. 
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Tables - Planetary Nodes 
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Tables - Fictional Planets of the Uranian or Hamburg school 

 

 

 

The positions of the fictitious planets are calculated and displayed in this window but are not available in the chart 

displayed in the inner, middle, or outer wheel. 

 
 
 

 

 

Go to: Main menu, Overview 
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Contextual menu 
 

The Contextual menu allows you to perform most of the basic operations of Mastro : 

 

The Quick Configuration - No Birth Time item positions the sign of Aries on the left, removes the houses and angles 

(Asc, Mc, Dsc and Fc). To return to the display according to your initial settings, you must click the menu item again. 

 

The item Show Inner and Middle Houses wheel displays the houses of the Middle wheel in its own wheel and projects 

its corners to the outside of the Middle wheel. The houses and angles of the Inner (native) wheel remain within the 

boundaries of the Inner wheel. Click the item again to return to the "standard" display where only one house choice is 

displayed at a time and spills over into the outermost wheel. This feature obviously only applies when there is data 

(transits, progressions, ...) in the Middle wheel. With this feature, you can only have the Inner wheel and the Middle 

wheel visible. The Outer wheel is not available. On the left panel header, for the Inner wheel and the Middle wheel, the 

icons (buttons) controlling the activation of the houses will be visible in "standard" mode but will not be visible when 

the houses of both wheels are displayed at the same time ("double house" mode). 

 

          
 

Go to: Main menu, Overview 

 

“Standard” 

mode. 

 

“Double house” 

mode. 
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Contextual menu - Quick setup - No Birth time  
 

The Quick Configuration - No Birth Time item positions the sign of Aries on the left, removes the houses and angles 

(Asc, Mc, Dsc and Fc). To return to the display according to your initial settings, you must click the menu item again. 
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Contextual menu - Display the houses of the Inner and Middle wheel (at the same time) 

 
The Inner wheel represents the numbering of natal houses, and the Outer wheel represents the numbering of houses in 

transit, in progression, in direction or with another method. This option applies to the Inner wheel with data in the 

Middle wheel. With this option, it is not possible to have data in the Outer wheel. Here is an example: 

 

 

 

Note that the visibility of the letters “A” (ascendant) and “M” (midheaven) (Inner wheel and Middle wheel) is controlled 

in the Preferences in the Tools menu and in the Planets tab. 

 
 

 

 

 

 

Go to: Main menu, Overview 

 

Natal 

houses. 

 

Houses of 

Transits, 

Progressions, ... 
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Graphics 

 

   

When you click on the Show Graphics command in the top band of the main menu, you can choose to display the graph 

of the planets in longitude or declination in the View drop-down menu at the bottom right of the window. By default, 

the Transit method is selected. If you call up this window with data on the middle wheel (transit or other) you will get a 

screen like the one shown above. If you only have a natal chart (inner wheel), you will get straight lines for each of the 

natal planets because they do not have declinations or longitudes that vary over time. 
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You can zoom in on a period by 

clicking on the graph and dragging 

the mouse cursor to the end of the 

desired period. 

 

Return to the normal size of 

the chart by clicking the 

button showing the Sun 

symbol. 
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Secondary progressions - Settings 
 

  

 

 

 

The secondary progressions represent the planetary positions on the nth day after birth. The number of days is 

equivalent to the age of the native and is multiplied by a daily step to arrive at the exact moment of the progression. 

The daily step is the mean solar arc, in longitude on the ecliptic, named Naibod or the true solar arc, in longitude on the 

ecliptic, between the position of the natal Sun and the position of the Sun at the age of progression. The angles are 

progressed in the manner of the primary directions: The solar arc found is added to the natal MC. We find the 

equivalent of this MC in right ascension (which is the measurement in hours on the equatorial circle), the RAMC (Right 

Ascension of MC). From the RAMC we calculate the positions of the houses according to the system used. 

The secondary progressions can be calculated according to a slow annual step, which is the usual way to calculate them. 

This movement causes Midheaven to advance about 1 degree and the Moon about 15 degrees in a year. The daily step 

moves the Midheaven and the angles one full turn of the zodiac and the Midheaven is positioned about one degree past 

the starting degree. 

The movement can be direct or converse. The converse movement calculates the days according to the age in the 

direction of the past. 

 

Go to : Main menu, Overview, How to display secondary progressions 

To open the Secondary Progressions - Settings window, right-click the SP 

button on the main menu or click the Secondary Progressions button on 

the Calculations tab in Preferences.  
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Solar arc directions - Settings 

 

 

 

 

 

The solar arc directions are calculated, initially, as a secondary progression, according to the true solar arc as described 

under secondary progression configurations.  

The angles are directed by adding the degree of the positions of the natal angles to the value of the solar arc calculated 

for the age of the direction. Thus, the natal angles and the progressed angles keep the same ratio. The progressed 

planets also keep the same ratio, but they are increased by the value of the progressed solar arc. 

The movement can be direct or converse. The converse movement makes the calculation of the days according to the 

age in the direction of the past. 

 

 

 

 

 

 

Go to : Main menu, Overview, How to display solar arc directions 

To open the solar arc direction settings, right-click 

on the SA button in the main menu or in the 

Preferences on the Calculations tab. 
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Tertiary Progressions - Settings 
 

 

 

 

 

 
Tertiary progressions are based on lunar motion while secondary progressions are based on solar motion. Tertiary 

progressions usually use the sidereal lunar month, also called lunation, which is the interval between two consecutive 

new moons. 

Type 1 has a lunar period movement, i.e., the planetary positions remain fixed for about 27 days.  

Type 2 has a progressive movement of planetary positions and angles. 

The abbreviations at the bottom of the screen are used in the method name displayed on the screen (optional) or in the 

printed reports. 

You can calculate angles according to 3 progression methods: Naibod, Solar Arc or 361° ... per progressive day. 

 

Go to : Main menu, Overview, How to display tertiary progressions 

 

To open the Tertiary Progressions -

Configurations, right-click on the TP button on 

the main menu or in the Preferences on the 

Calculations tab. 
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Display options for date and time. 

 

 

When you right-click on the Date or on the Time (in the center or in a moving panel) and choose Display option for date 

and time, you get the following window: 

 

 

 

 

 

 

 

 

Go to:  Main menu, Overview, Modify Date 
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Preferences 

 

Preferences are accessible from the Tools menu or the Contextual menu. 
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Preferences - General 
 

In Preferences, you can change the location called Current place and adjust the display of certain information. This 

Current place will be the default when you open a transit chart. 

 

  

In the Current place field, enter your city and click Search. If your city is not in the database, choose the nearest city in 

the database that uses the same time zone (historically). If you choose a time difference instead by selecting a value in 

the TU Offset field, no correction for time variations (summer/wintertime) will be automatically made in the transit 

calculations. The time will always be considered as "Standard". 

NOTE: City names are in English and do not have accents - Ex: "Montreal" instead of "Montréal", "Brussel" instead of 

"Bruxelles" ... 

Mastro will automatically convert accented characters to non-accented characters. Many cities with compound names 

have a draw between the words. Examples: "Aix-en-provence", "Trois-rivieres".  

Cities that begin with "Saint" are also followed by a dash. Example: "Saint-Jérôme". 

By default, it is Declination that is selected for Declination or Latitude since declinations give rise to parallel and counter parallel 

aspects. 

 

Go to:  Main menu, Overview 

The Zoom factor is only 

available for screens with 

a resolution of 

1920X1080. 

. 

Display parameters for 

the name, date, time, 

method, longitude, and 

declination or latitude 

degrees of a planet under 

cursor. 

 

Chart display settings at 

Mastro startup. 
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Preferences - Appearance 
 

 
The Appearance tab is the place to adjust the size and color of certain objects. 
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Preferences - Planets 
  

 

For a planet to be displayed on a chart, it must be checked in the appropriate column (Inner, Middle, Outer).  

You can choose to display the True or the Mean Lunar Node. 

You can choose to display the True, Mean Black Moon or Interpolated Lilith. 

For Vedic charts, it is possible to add the planets Uranus, Neptune and Pluto which are not traditionally included.  

 

 

 

 

 

 

 

 

Go to :  Main menu, Overview 
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Preferences - Aspects  
 

 

                

The configuration of the aspects includes the adjustment of the orbs. For each aspect in the left column, on a line, you 

can adjust the color of the line, the type of line (dotted, continuous, ...), the width of the line and the H or D value which 

means you want to consider the aspect as harmonic or dissonant. Some astrologers think the 150° aspect is dissonant 

and others will say it is harmonic. The choice is yours. However, although it is possible to change the nature of aspects 

to harmonic or dissonant with H or D, according to tradition, aspects of 180°, 90°, 45° are dissonant and aspects of 120° 

and 60° are harmonic: in principle, they should not be changed. The orbs of parallel or contraparallel aspects are 

generally equal to or less than 1°. The same is true for aspects to fixed stars. To adjust the orbs applying to aspects 

between planets, asteroids, North Node, Asc, MC and Vertex, you must first ask yourself if these are variable according 

to the planets (and other points), according to the aspects or both. The simplest procedure for making your orb choices 

is to use Aspects and Orbs by angle. Otherwise, if you use the procedure Aspects and orbs by planet, you must first 

choose an Orb Calculation Method. In both cases, you must then click on Orbs Setting.  

 

 

 

 

Go to :  Main menu, Overview 
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Preferences - Aspects - Orbs Setting 
 

By default, orbs for aspects are based on experience and some research, but they can be changed. 

 

  

 

If you have chosen the procedure Aspects and orbs by angle in the tab Preferences - Aspects, you will get the left 

window and if you have chosen the procedure Aspects and orbs by planet you will get the right window where a planet 

column will appear.  

Then, in either procedure, change the orb values in the Orb column and check the box in the Show Aspect column for 

the aspects you want to display on the chart. This way you can adjust all the orb values and the choices of whether to 

display in each of the two procedures.  

You can also select the method from the Method drop-down menu, instead of scrolling down the grid. If you select a 

method, you will be able to access the quick adjustment and copy the values of this selected method to apply them to 

other methods. 
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121 
 

Mastro - User guide - v.7.7 (May 2025) 

Preferences - Midpoints 
 

By default, orbs for mid-points are based on experience and some research, but they can be changed. 

To adjust the midpoint orbs: 
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Preferences - Calculations 
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Preferences – Options for methods 
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Preferences - Behaviors 
 

Adjustment to Mastro's automatic behaviors including: 

• Adjustment for automatic or no correction to time changes.  

• Adjustment for coordinates to be used by default according to some methods. 

• Display of tooltips. 
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Preferences – Messages and Alerts 

 

To enable or disable certain messages in the application you check or uncheck one of these options: 
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Preferences - Rulership 
 

Adjustment of rulership according to various authors, for the display of subdivisions, and adjustment of dignities: 
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Preferences - Lots (Parts) 
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Preferences - Elective Astrology 
 

Elective astrology parameter that affects Mastro's behavior. 
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Save and recall preferences. 
 

In the Tools menu at the Preferences item, you get the preferences window where you can adjust your working 

environment: display or not a panel, adjust the color of an element, the size of the planets, the background color of the 

zodiac, the orbs used, the visible aspects, the visible planets, etc. This set of parameters can be stored in a Mastro 

directory and recalled at will.  To create a set, click on Preference Set. 

 

      

 

 

 

 

If you make changes in the preferences and want to keep them, click the New Set button. The Description field will 

become editable. Enter a unique description and click the Add button.  

An example: you want to search with certain planets, certain angles, and a set of distinct orbs. Make your choices of 

planets, visible aspects and orbs and then add the set here. 

The created sets are in the list and can be reactivated by selecting them and clicking on the Activate Set button. 

 

 

 

 

 

Go to:  Main menu, Overview 

Active set of preferences  

 

The first item in the list is the initial set (initial configurations) 

of Mastro. This item cannot be deleted. 

If you want to restore Mastro to its original state, select this 

item and click on Activate Set. 
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Backup copy of your User Data 
 

Pour faire une copie de sauvegarde sur une clé USB, au menu Outils, sélectionnez « Gestion des données ». 

  

In the Data Management window, select Show Data Directory. 

 

  

Select all the files and subdirectories, including the "UserDatabase.sdf" file, and copy them to your key. 
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Notes on the database of cities and time changes 

 

We are aware of the problem with the accuracy of historical time change data, not only in U.S, Canada, France and 

elsewhere.  

“The time change data may not be accurate over all time and location. It is always best to validate the data used. For 

the oldest data, the historical time change database starts in 1800.” 

It is difficult to take a position when faced with contradictory information. Mastro mainly uses the database provided by 

the organization https://www.iana.org/time-zones, also called "Olson database" after its creator. This database is not 

100% reliable before 1974. For this reason, and because our primary mission is to produce a tool for calculation and 

interpretation, we delegate to the user the responsibility of validating the information regarding temporal and spatial 

coordinates. 

As we do not have access to the memory of our grandmothers and grandfathers nor to all the legal registers of all the 

cities in the world, we have chosen to offer users the possibility to create their own personal database where they can, 

according to their research, put the cities, countries, and time zones they want.  

From time to time, we revise our database, but this is mainly based on the changes made to the Olson database 

mentioned above. 

Also, it is not impossible that we will eventually propose an alternative database with even more reliable information. 
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Keyboard shortcut 
 

 Keys and Calendar – Date and Time Navigation 

Keys Move to 
(Days Calendar Level) 

Move to 
(Months Calendar Level) 

Move to 
(Years Calendar Level) 

⇨ Next day Next month Next year 

⇩ Next week Four months later Four years later 

⇦ Previous day Previous month Previous year 

⇧ Previous week Four months before Four years before 

CTRL + ⇨ Next month Next year Ten years later 

CTRL ⇩ Next month Next year Ten years later 

CTRL + ⇦ Previous month Previous year Ten years before 

CTRL + ⇧ Previous year Previous year Ten years before 

CTRL + N Now 
  

H Next hour 
  

CTRL + H Previous hour 
  

M Next minute 
  

CTRL + M Previous minute 
  

S Next second 
  

CTRL + S Previous second 
  

  

The keys on the keyboard – other features:  

Touches de clavier Description 

CTRL + A Enable/disable the permanence of the plotting of aspects (toggle key) 

CTRL + B Show/Hide the scan panel (toggle key)  

CTRL +W Select active wheel/chart: Inner, Middle, or Outer 

CTRL + D Display houses of inner, middle, or outer chart 

CTRL + E Open "Save Event" window 

CTRL + l Expand or collapse the "Interpretations, analysis and synthesis" panel (**)  
CTRL + K Empty/keep keywords list in the delineation panel (toggle key) (**)  
ALT + T Opens a transit chart in the middle wheel at the present time 
ALT + N Opens the input window for a new chart 
ALT + O Opens the existing theme selection window  

X Expand or collapse the "Interpretations, analysis and synthesis" panel (**)  

Z Delete the interpretations in the "Interpretations, analysis and synthesis" panel (**) 

Esc Close an open window  

  
(**) Only available in Mastro Expert. 
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User interface - some definitions 
 

Main menu: This is the menu at the top of the Mastro main window. Menus contain submenus (menu 

items). On the menu bar there are also command buttons or drop-down menus. 

  

 

 

Contextual menu: A contextual menu is always called with a right mouse click on an interface element. For 

example:  

• Right click on an element of a list (scan list of aspects, list of charts, ...) 

 

 

 
• Right click on an empty space in the main window: general contextual menu 

 

 

 

Go to:  Main menu, Overview 

 

The Tools Menu contains 

menu items and sub-menus. 

Context menu for an item in the 

aspect list. Right-clicking on a row 

calls the context menu and its menu 

items: Load this transit (TR), Save all 

scan results to.... etc. 
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Tabs: There are tabs in the Preferences window that group commands by category (Planets, Aspects, 

Appearances, etc.).  

In the main window, on the left of the screen, there are three tabs: 

• Command 

• Charts List  

• Moon phases 

 

Panels: Some panels, including those located in the Commands tab, can be expanded, or collapsed by clicking 

the arrow button 

           

 

 

Commands / Controls: Most panels contain controls in the form of buttons, icons, images, lists, radio 

buttons, drop-down menus, etc.  

  

Preferences: When we talk about "preferences" we are referring to the Preferences item in the Tools menu. 

Preferences are grouped by theme under tabs in the Preferences window. The choices of houses, zodiacs, 

reference planes, ayanamsha and ascendant orientation are determined on the main screen, under the 

Commands tab      , in the Houses and Zodiac panel. 

 

Cursor: Refers to the position of the mouse on the screen. 

Transits: The ephemeral passage of a planet over the place of a Significator, Moderator or planet, or over any 

point where it forms an aspect to them with an element of a natal chart or a chart of progressions or 

directions. 

Progressions: The progressions are based on solar motion. The actual planetary positions are calculated on 

the nth day after or before (converse motion) the birth and represent the nth year of life. The number of 

days is equivalent to the age of the native and is multiplied by a daily step to arrive at the exact time of the 

progression. The daily step is the average solar arc, in longitude on the ecliptic, called Naibod or the true 
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solar arc, in longitude on the ecliptic, between the position of the natal Sun and the position of the Sun at the 

age of progression. The angles are progressed in the manner of the primary directions.   

 

Secondary progressions: Secondary progressions are the planetary positions on the nth day after birth and 

represent the nth year of life. The number of days is equivalent to the age of the native and is multiplied by a 

daily step to arrive at the exact time of the progression. The daily step is the average solar arc, in longitude 

on the ecliptic, named Naibod or the true solar arc, in longitude on the ecliptic, between the position of the 

natal Sun and the position of the Sun at the age of progression. The angles are progressed in the manner of 

the primary directions.  For more information, see the section How to display the secondary progressions 

(PS). 

Tertiary progressions: Tertiary progressions are based on lunar motion, there are two types in Mastro. For 

more information, see the sections and How to display the tertiary progressions (PT) 

Direct/Converse: The movement of the planets in their natural direction is called direct motion. This motion 

can be reversed and traced back in time from birth. This reversed motion is called converse motion.  

Directions: Directions are based on a shift in natal positions, unlike progressions which are based on actual 

positions by observing a specific time after or before (converse) the birth. 

Primary Directions: They are based on the diurnal rotation of the Earth on its axis, an arc known as the 

Primary Directions. The measure used is the time elapsed during which a complete degree of Right Ascension 

crosses the meridian, approximately 4 minutes of Sidereal Time. All the Primary Arcs that can be formed 

between the sensitive points of a Nativity during a whole life are formed during about 6 hours after the birth 

and are produced only by the rotation of the Earth on its axis: the planets keeping their radical places and 

being thus transported around the heavens to form aspects to the significators' places. The reliability of the 

method depends on the accuracy of the time of birth to a fraction of a minute because an error of 4 minutes 

in the time of birth leads to an error of one year in the chronology of an event.  

Significator:  A planet can be considered as the significator of a person or event, or of the affairs governed by 

a House. Its strength by virtue of its position in the Sign and House and its relationship through aspects are 

then consulted to arrive at a judgment regarding a desired condition. In general, the strongest planet in the 

figure, usually the ruler of the Ascendant, is considered the Significator of the native. Likewise, the ruler of 

the sign located on the cusp of the second house is considered the Significator of wealth, the seventh house 

of the partner, the eighth house of the partner's wealth, and so on. 

Promissor: Planet towards which a significator can be "directed" (in primary direction) in order to form an 

aspect between the "progressed position" of the significator and the "birth position" of the promissor, by 

which certain events or conditions are promised with regard to the significator so directed. The distance that 

the significator must travel to form this aspect is called "arc of direction", to be brought back to the time, 

generally at the rate of 1° for a year and 5' for a month. 

Solar arc direction: Directions are based on a shift in natal positions, unlike progressions which are based on 

actual positions by observing a specific time after or before (converse) birth. The sun advances about 1 

degree per day and represents one year of life. All natal positions (angles and planets) advance by the actual 

or average arc (NAIBOD) with age. 
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Applying/Separating: When observing planetary movements, for a given aspect: 

• If the angle decreases, we say that the aspect is applying or in application. 

• If the angle increases, we say that the aspect is separating or in separation. 

Applying or separating aspects can be indicated by a color on the dynamic aspectarium grid. The colors are 

adjustable in the Options in the Interpretations, Analysis and Synthesis panel (Commands tab on the main 

Mastro window). In the list form, the aspects applying, or separating are indicated under the A/S column. 

According to the definitions in the Devore dictionary, aspects are more powerful when they form than when 

they separate. If either planet is retrograde, the influence is said to be detrimental, or the promised result is 

so subject to delay that it is of little value when it materializes. 

Method (Calculation Methods):  Transits, Progressions, Directions, Profections, … 

Resonances / Resonance aspect: A planetary pair forms both an aspect on the inner wheel and at the same 

time the planetary pair makes an aspect on the middle wheel. 

 

Other sources of information: 

• Primary direction – On primary direction. 

• Astrology (Wikipédia) – General information about astrology. 

• http://www.zaytsev.com/Devore/main.html - Astrological dictionary Nicholas Devore. 

• https://www.deepl.com/translator - translator english/french.  

• https://www.timeanddate.com/ - Information on time changes and time zones 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Go to:  Main menu, Overview 

  

•%09:%20https:/astrology.martingansten.com/wp-content/uploads/2020/08/PrimaryDirectionsChapter.pdf
https://en.wikipedia.org/wiki/Astrology
http://www.zaytsev.com/Devore/main.html
https://www.deepl.com/translator
https://www.timeanddate.com/
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Note that the appearance can be represented in glyph, degree or letter format depending on the choice made in the 

options (Options button in the Interpretations, Analysis and Synthesis panel). For the 3rd choice of format, the letters 

C, H and D respectively mean conjoint, harmonic, and dissonant. Generally, D (dissonant) is associated with 180°, 90°, 

45° or 135° and H (harmonic) is associated with 120° or 60°. The association between aspects and their type (harmonic 

or dissonant) is made in the preferences window (Tools menu in the Aspects tab, under the H / D column). 

 

 

Interpretation tools - Interpretation options - Tooltips 

 
To display tooltips with keywords for planets, signs, and houses, open the Interpretations, Analysis and Synthesis 

panel, click the Options button, and then check the Show tooltips box. 

When the cursor is over a point such as the Sun, a yellow box with keywords (planet, sign, house) appears near the 

point. To make the yellow box disappear, simply place the mouse over it or press the Escape key (Esc). It is not 

necessary to click in the box. If you move the cursor to another point, the first box will disappear and another one will 

appear near the point under the cursor. 

 

 

In Options (Interpretations, Analysis and Synthesis) 

you can choose the Glyph, Degree, or letter format. 

 


